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Excourse Software License and Warranty

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT "LICENSE" CAREFULLY. IF YOU DO NOT AGREE TO THE TERMS OF

THIS LICENSE, RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A REFUND (IF APPLICABLE).

1. License. The software, documentation accompanying this License whether on disk, in read only memory, on any other

media or in any other form (the “Software”) are licensed to you by Excourse. You own the media on which the Software is

recorded but Excourse and/or Excourse's licensor(s) retain title to the Software. The Software in this package and any copies

which this License authorizes you to make are subject to this License.

2. Permitted Uses and Restrictions. This License allows you to install and use the Software on a single computer at a time.

This License does not allow the Software to exist on more than one computer at a time. If you are using demonstration ver-

sion of the Software, you may use such Software on as many computers as you choose without restrictions. You may make one

copy of the Software in machine-readable form for backup purposes only. The backup copy must include all copyright infor-

mation contained on the original. Except as expressly permitted in this License, you may not decompile, reverse engineer, dis-

assemble, modify, rent, lease, loan, sublicense, distribute or create derivative works based upon the Software in whole or part

or transmit the Software over a network. THE SOFTWARE IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR

FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, OR AIR TRAFFIC CONTROL MACHINES IN WHICH

CASE THE FAILURE OF THE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRON-

MENTAL DAMAGE. Your rights under this License will terminate automatically without notice from Excourse if you fail to

comply with any term(s) of this License.

3. Limited Warranty on Media (if applicable). In the event that you paid Excourse for the Software to be delivered on

media, then Excourse warrants the media on which the Software is recorded to be free from defects in materials and work-

manship under normal use for a period of ninety (90) days from the date of original retail purchase. Your exclusive remedy

under this paragraph shall be a replacement of the Software which is returned to Excourse or an Excourse authorized repre-

sentative with a copy of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA INCLUD-

ING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED IN

DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE.

4. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software is at your sole risk.

The Software is provided “AS IS” and without warranty of any kind and Excourse and Excourse's licensor(s) (for the purposes

of provisions 4 and 5, Excourse and Excourse's licensor(s) shall be collectively referred to as "Excourse") EXPRESSLY DIS-

CLAIM ALL WARRANTIES AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A PARTICU-

LAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. EXCOURSE DOES NOT WARRANT THAT THE FUNC-

TIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE

WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHER-

MORE, EXCOURSE DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF

THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILI-

TY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY EXCOURSE OR AN EXCOURSE AUTHO-

RIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.

SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT EXCOURSE OR AN EXCOURSE AUTHORIZED REPRESENTA-

TIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL EXCOURSE BE LIABLE FOR

ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE.

In no event shall Excourse's total liability to you for all damages exceed the amount of one US dollar ($1.00).

7. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of the

Software and supersedes all prior or contemporaneous understandings regarding such subject matter. If any provision of this

License is found by a court of competent jurisdiction to be unenforceable for any reason, the remainder of this License shall

continue in full force and effect. No amendment to or modification of this License will be binding unless in writing and

signed by Excourse.

LibTIFF Copyright and Permission Notices

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software (LibTIFF) and its documentation for any purpose is hereby

granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the soft-

ware and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or

publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE (LIBTIFF) IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHER-

WISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PUR-

POSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR

CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR

PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING

OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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ABOUT EXCENTRO WINDOWS REFERENCE

Excentro Windows Reference book provides complete reference of all windows and

dialogs you have a chance to encounter while using Excentro application. It is devised to

be used in conjunction with accompanying Excentro Commands Reference,

Excentro Objects Reference and Using Excentro guides.

This book is not designed to be read from cover to cover, one chapter after another,

though of course it could be read this way. We suggest you to use Excentro Windows

Reference as reference (as it name implies): when you need to look up description of

some window, dialog or fields and controls they contain, appropriate chapter of this

book will give you all information you need. You are advised to read complete chapter

with specific window or dialog description, because it can contain other information on

same subject you will find useful.

Most significant windows of Excentro application and their chapter numbers:
2–Excentro Preferences dialog, 3–Main document window, 4–Document preview 

window, 5–Excentro Control inspector, 6–Property Inspector, 7–Color Mixer, 
8–Swatch Palette window, 9–Toolbar

Chapters of this book are organized in order of windows and dialogs importance:

Chapter 1 covers Excentro Registration dialog. This is not exactly the most

important chapter of this book, we put it in front, because this dialog is the first

window you will see when you start Excentro application for the first time.

Chapters 2, 3, 4, 5 and 6 are definitely ‘must read’ chapters they cover Excentro
application preferences, document windows, Excentro Control inspector and

Property Inspector. Please, try at least to leaf through these chapters and look at

illustrations to get basic idea on purpose and usage of these windows. 

Other chapters of this book are not that crucial for guilloche design creation in

Excentro, their purpose can be guessed with common sense or they have ana-

logues in other graphics design application. Last chapters cover minor dialogs and

informational windows like About Excentro or Clipboard.
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We cover both Mac OS 9 and Mac OS X versions of Excentro windows. Whenever possi-

ble we use Mac OS 9 versions of screenshots for illustrations. There are two main reasons

for us to do it:

1. Most of those who use Mac OS X used Mac OS 9 not so long before it, so they are

also accustomed to older windows and menus look, unlike those who still use Mac
OS 9. Those who can not use Mac OS X for some reasons can be easily confused by

new Aqua appearance, so we minimized use of new windows and menus where

we could.

2. Antialiased text and transparent windows with striped background are pretty

cool features on computer screen. However older screenshots still look better

when printed on paper and produce smaller size PDF format documents.

Type conventions used in this book are the same as in other guides and references for

Excentro application:

Bold type style is used to expose titles of windows, dialogs, menu commands and

other interface elements like controls and buttons. It also is used for titles of other

chapters and books of Excentro guides.

Italic type style is used for names of applications, software products and names of

companies that produce them. Sometimes this style is used also to show sample

numeric and string values you can enter in fields of dialogs.

We hope this would be enough to give description of Excentro windows and dialogs

without using additional typefaces, styles and sizes.

Sometimes you will encounter Comments at the end of sections and chapters. You can

skip these, since they do not contain information of practical value. But you may find

them interesting to look at if you have a spare minute.
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CHAPTER 1: EXCENTRO REGISTRATION DIALOG

Registration dialog is the first dialog that welcomes you when you launch Excentro
application for first time after installation.

In this dialog you can either enter your personal information and valid serial number of

your copy of Excentro to register it, or click Demo button to choose working with

Excentro in demonstration mode.

Demonstration mode allows you to explore Excentro features and/or use it for occasion-

al jobs, but it has a single feature limitation: you can not save documents in native

Excentro format. All other features including export in Adobe Illustrator format work

without limitations.

When Excentro runs in demonstration mode Excentro application menu (Mac OS X) or

Apple menu (Mac OS 9) contain one additional command: Purchase Online… This

command could be used to access online store where you can purchase full Excentro
license with credit card. Your Macintosh should be connected to internet to access pages

on World-Wide-Web.

Excentro Windows Reference
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After Excentro is purchased you will get your individual serial number you can enter in

Serial Number field of Registration dialog. OK button will become active and you

can click it to register your copy of Excentro.

Registration dialog will not appear again on application start up after Excentro was

registered with valid serial number. If you use Excentro in demonstration mode

Registration dialog appears every time you restart the application.

Comments: If you have problems with your serial number, for example: it no longer
works after you upgraded Excentro to next version, please, contact Excourse to receive
your new serial number or more details about the version upgrade. Excourse contact
information could be found on first pages of this book or in read me file that comes with the
version upgrade.
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CHAPTER 2: EXCENTRO PREFERENCES

Excentro Preferences dialog controls application-wide settings like measurement

units or color space profiles, as well as application presets like common stroke weights

or document page formats.

To configure Excentro Preferences choose Preferences command from Excentro

application menu (Mac OS X) or Edit menu (Mac OS 9).

Excentro Preferences dialog consists of five panels: General, Colors, Export, Page

Sizes and Strokes. You may switch between these panels by clicking icons in top part of

the dialog. General panel is selected by default when Excentro Preferences dialog

appears on screen in front of you for the first time.

Apply button saves the changes you made to fields and controls in all Excentro

Preferences dialog panels (please, do not forget to press this button before closing the

dialog!).

To close the dialog without saving the changes or after the changes are saved, just click

close button in top left corner of the dialog window.

Defaults button restores standard values (so called ‘factory presets’) for fields and con-

trols in all Excentro Preferences dialog panels. You may want to click this button if

you would like to reset document page formats to standard set of ISO formats, for exam-

ple.
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GENERAL

If General panel is not on your screen, click General icon in top part of Excentro

Preferences dialog.

This panel is where you set up application-wide measurement units for all fields and val-

ues in windows, dialogs and controls, as well as grid settings for Excentro document pre-

view windows.

General pop-up menu allows you to set up measurement units that will be used to dis-

play and change object attributes like dimensions and offsets. These are also measure-

ment units for horizontal and vertical rulers in Excentro document preview windows.

There are four possible choices: Millimeters, Centimeters, Points and Inches. Our

suggestion is to use either Points or Millimeters, since these are more comfortable

units while working with small objects and values.

Stroke pop-up menu allows you to choose between Points and Microns as stroke

weight units. 1 micron is about 0.0028 pt. Your country security printing regulations may

refer to microns as standard measurement units for stroke weights and lines thickness

specification. Otherwise, or if you are more comfortable while working with values in

same measurement units as in standard illustration packages like Adobe Illustrator or

Macromedia FreeHand, select points as measurement units in this pop-up menu.

Decimal digits pop-up menu specifies how many digits you would like to see after a

decimal point in application dialogs and information fields. If you need extra precision

for your design work (and you probably do) select 3 or 4; or you may leave it at default

value of 2 for convenience.

Document grid section allows to choose color and size for grid in document preview

windows (see picture on next page). When grid is visible sizing and positioning of

objects could be easier tasks to do. (To switch grid visibility, you can use Show Grid and

Hide Grid commands from View menu.)
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If you click Color button, standard Mac OS System color picker window will open up,

where you can select color you like using color wheels, RGB and CMYK color sliders or

crayon pickers.
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COLORS

If Colors panel is not on your screen, click Colors icon in top part of Excentro

Preferences dialog.

Excentro utilizes Apple ColorSync™ technology to display proper object colors on screen

and convert color values between different color spaces. This panel lets you set up

ColorSync profiles for each color space you may want to use (like RGB or CMYK). If you

have system ColorSync environment of your Macintosh properly set up you do not have

to make any changes to default settings in this panel.

We will not cover topics like color management, profiles, rendering intents in this refer-

ence. If these conceptions are new to you, you should read some introductory material

provided by Apple or appropriate sections in Adobe or Macromedia user guides.

Default Profile selection in CMYK Profile, RGB Profile and Gray Profile pop-up

menus refers to color space profiles selected in Mac OS System ColorSync preferences.

The only color option in Excentro, that is different from standard ColorSync implemen-

tation in other graphic arts applications is Use profiles to convert from Gray to

CMYK checkbox:

■ When this checkbox is off and you will try to convert grayscale value to CMYK

color space (using Excentro Color Mixer Inspector window), K component of

new CMYK color will be set to same value as gray shade of grayscale color, while

CMY components will remain at zero. For example: ‘50%’ Gray value will be con-

verted to ‘C=0%, M=0%, Y=0%, K=50%’ CMYK values.

■ When this check box is on Excentro will use selected ColorSync profiles for

grayscale to CMYK conversion and result will be more accurate for present devices

but less obvious for human operator. For example: ‘50%’ Gray value will be con-

verted to something like ‘C=50%, M=38%, Y=38%, K=4%’ depending on profiles

selected for CMYK and Grayscale color spaces in popup menus above. 

Default value for Use profiles to convert from Gray to CMYK checkbox is off.

If you need, you can switch off color management completely with Use ColorSync™

checkbox located in top part of the panel.
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EXPORT

If Export panel is not on your screen, click Export icon in top part of Excentro

Preferences dialog.

In this panel you can set up options that will be used to export documents in Adobe
Illustrator file format at the final step of your Guilloche design creation process in

Excentro.

When Include invisible paths checkbox is off only paths with Visible attribute (rep-

resented with ‘light bulb’ icon in Excentro main document windows) will be included in

exported document. When this checkbox is on invisible paths will be exported too.

These paths will have no stroke nor fill attributes. You can set these attributes later in

Adobe Illustrator or use these paths as guides or clipping paths.

If Include invisible layers checkbox is off only layers with Visible attribute (the ones

with ‘light bulb’ icon in Excentro document layers list) will be included in exported doc-

ument. We provide this option for convenience, so you could export only needed,

presently visible, layers without deleting invisible ones beforehand. When this checkbox

is on invisible layers will be exported as similar invisible layers to Adobe Illustrator for-

mat as well.

When Include unused swatches checkbox is off only swatches used to colorize one

or more paths with Visible attribute will be included. When this checkbox is on all

swatches defined in Excentro document will be included in exported document. This

option could be useful if later you would like to colorize other objects in Adobe
Illustrator document with colors from defined in Excentro palette.

You can select a vector-based design application like Adobe Illustrator or Macromedia
FreeHand to open exported file immediately after export procedure is complete. To acti-

vate this option you should switch on After export open file with application

checkbox and select proper vector drawing application either with drag-and-drop

action of application icon from Finder window to file well below the checkbox or using

adjacent Select… button and standard Mac OS system Choose Application dialog box

(that will appear after you click the button).
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PAGE SIZES

If Page Sizes panel is not on your screen, click Page Sizes icon in top part of Excentro

Preferences dialog.

In this panel you can define set of page formats that will be used to size new or resize

existing Excentro documents. This set of formats appears in Page Size popup menu in

New Document window (when you select New command from File menu to create

new document) or in Document Setup window (when you select Document Setup

command from File menu to change size of current open document).

Document page size only helps to limit work area visually to simplify objects positioning

and location (see picture on next page). You can always change page size of current

open document with Document Setup command at any convenient time.
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If jobs you are working on in Excentro come in few predefined sizes (e.g. series of certifi-

cates or plastic cards that differ from standard in size) you can edit formats list in Page

Sizes panel of Excentro Preferences dialog to add formats you use often and remove

ones you do not need. After that you will not have to enter manually your nonstandard

document’s width and height each time you create new documents, just select right pre-

defined format from popup menu.

Default page sizes include set of popular ISO and US paper formats and plastic card for-

mats.

To add new page format to the formats list click New button below the list, after that

type Name of new format and enter Width and Height for this page format.

To remove existing page format from the list select it with mouse click, then click

Delete button below the list.

List of page formats in Page Size popup menus in New Document and Document

Setup windows will be sorted in the same way as items in page formats list in Page

Sizes panel. You can sort items by Name, Width or Height attributes in ascending or

descending order. To change sort order use title buttons of list columns.

Do not forget to click Apply button before closing Excentro Preferences dialog, oth-

erwise changes you made to page formats list (and other unsaved changes to settings in

Excentro Preferences dialog) will not be saved.
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STROKES

If Strokes panel is not on your screen, click Strokes icon in top part of Excentro

Preferences dialog.

In this panel you can set up presets that will appear in Stroke popup menu of

Excentro Control window. (This menu pops up when you click arrow-down button

beside Stroke field in Path panel of Excentro Control window.)

Stroke presets are provided for convenience: in most cases your documents will have

paths of only three or four different stroke weights (e.g. strokes of 0.25 pt are used for

background paths, strokes of 0.4 pt and 1.0 pt for everything else). It will be easier to

assign these values if you edit list in Strokes panel of Excentro Preferences dialog so

that only these weights are left in the strokes list and popup menu of Excentro

Control.

To add new stroke preset to the list click New button below the list, then type Name for

new stroke and set its Weight attribute.

To remove stroke preset from the presets list select it with mouse click, then click

Delete button below the list.
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Presets in Stroke popup menu will be sorted in the same way as the sort order of items

in the Strokes list. You can sort items by Name or Weight attribute in ascending or

descending order by clicking appropriate column titles.

Do not forget to click Apply button before closing Excentro Preferences dialog, oth-

erwise changes you made to stroke presets list (and other unsaved changes to settings in

Excentro Preferences dialog) will not be saved.
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CHAPTER 3: MAIN DOCUMENT WINDOW

Each Excentro document has two windows to display its contents: main document

window that shows document structure, layers list and colors list and document pre-

view window that shows graphics representation of guilloche design. Main docu-

ment window is usually located in left half of the screen and its title is the same as the

document name, document preview window is placed beside it in right part of the

screen and has <view> suffix added to the document name in its title.

Unlike other graphics design applications Excentro does not allow direct manipulations

with document content in preview window. This window just displays results of guil-

loche design creation and allows only objects selection by clicking paths that belong to

them with mouse pointer. To manage all contents of Excentro document you should use

main document window instead.

Main document window has three distinct parts: 

A. Structure pane shows tree-like structure of guilloche objects that belong to

single layer of the document. This pane is where you can create new objects,

rearrange their positions in guilloche structure and change objects attributes.

B. Layers list displays document layers with their properties and list of objects on

each layer in front-to-back drawing order. This list is similar to that of Layers

palette of Adobe Illustrator or Layers panel of Macromedia FreeHand.

C. Colors list manages colors set used to colorize guilloche paths in this docu-

ment. As with layers list, this list is similar to that of Swatches palette of Adobe
Illustrator or Swatches panel of Macromedia FreeHand.

We decided not to use floating palettes to show document layers list or colors list,

because, due to the fact that every Excentro document already has two windows to show

its contents, that would make work with multiple documents too confusing.Having

these lists shown in main document window can also simplify copying of layers and

swatches between documents with drag-and-drop actions.
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Layers list and colors list are located on resizeable pane in left part of main document

window. Initially, when you create new Excentro document, this pane is hidden. To

make it visible or hide it again you can use Show Layers and Swatches/Hide Layers

and Swatches command from main document window menu (button with triangle

in top right corner of the window).

If resizeable pane is hidden choosing Show Layers and Swatches command will make

make it visible:

When resizeable pane is visible the title of this command changes to Hide Layers and

Swatches. Choosing this command will hide layers list and colors list again.

Next sections of this chapter provide detailed reference on every part of main docu-

ment window.
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A: STRUCTURE PANE

Structure pane of main document window shows tree-like structure of guilloche

objects that belong to single layer of Excentro document. This tree-like structure repre-

sents creation process of guilloche design. For better understanding of this process you

may want to see overview of Excentro mechanical model in Chapter 2: Basic

Conceptions of Using Excentro guide. In this reference we will not venture into

description of mechanical background. 

The shape of guilloche design is defined by number of guilloche objects it consists of,

their attributes and their place in structure tree. Root objects of the tree are called ‘base’

elements. Path of base element defines basic type of the design: it could be linear for

bands and backgrounds or circular for rosettes. Other guilloche elements located on

next levels of tree hierarchy may have one or two parent objects. As parent objects they

can use either root objects or other objects on previous levels of hierarchy.

If the object has only one parent object it is regular ‘element’. Regular elements represent

modifications of their parent object path and could be regarded as skeleton bones that

define shape of guilloche design. If the object has two parent objects it is ‘content ele-
ment’. Content elements fill space between two parent paths and could be regarded as

flesh that adds texture and substance to guilloche design body.

Structure tree illustration: base element (shown with blue), regular elements (shown with
red) and content elements (shown with green) of simple guilloche rosette.

Objects of structure tree are represented as a set of interconnected rectangles in struc-

ture pane of main document window. Connection lines between rectangles could be

of two different kinds:

■ Black connection lines show parent-to-children relationships. Regular elements

have single black connection line to their parent object on previous level of hierar-

chy. Content elements have two black connection lines: first line to their parent

object on previous levels of hierarchy and second line to their second parent

object that could be in arbitrary location on this or another branch of the tree.

■ Green connection lines are shown for objects that have other objects set as

‘direction’ elements. Paths of direction elements are used as guides for paths of

these objects. See Chapter 2: Basic Conceptions of Using Excentro guide for

mechanics details and explanations.
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To manipulate objects of structure tree (to create new objects or change configuration

of existing ones) you can use commands of Structure menu in Excentro menu bar and

their shortcut buttons in Toolbar window. Some operations could be easier accom-

plished by drag-and-drop actions with rectangular representations of the objects.

Attributes of individual objects are changed with Excentro Control inspector. You

should select object you want to modify with mouse click on its rectangle in structure

pane and its attributes will be set ready for modification in Excentro Control.

HORIZONTAL OR VERTICAL VIEW

Structure pane supports two view modes for guilloche tree structure: horizontal or verti-

cal view. These view modes could be changed by choosing options from window menu

of main document window (button with triangle in top right corner of the window).

Check box appears beside the view mode title when it is active.

Different view modes of same tree structure are shown on following picture:

Excentro Windows Reference

Chapter 3: Main Document Window

3-4



■ Horizontal View mode is more appropriate for novice users or for guilloche designs

with ‘narrow’ structure tree. It shows structure tree in genuine ‘tree-like’ way with root

objects at top, next levels of hierarchy below previous ones, children objects centered

relative to their parent object.

■ Vertical View mode shows root objects at left, levels oriented vertically, children

objects top-aligned relative to their parent object. This mode is more convenient for

experienced users who work with large designs. When document contents many objects

that no longer fit in window size without scrolling, scrolling in vertical direction is more

natural to perform. You also do not have to resize main document window and as a

result overlap its companion document preview window to see all objects of ‘wide’

structure tree.

OBJECTS REPRESENTATION

Guilloche objects are shown in structure pane as small rectangles that show type and

general attributes of the object.

These are the same attributes as shown in window of Excentro Control inspector for

that object, but displayed in one compact view

This rectangle also contains small preview of object path, so you could identify this

object in document preview window easier.

■ You can use two last options of window menu of main document window to

switch on and off display of additional object attributes from Type and Transform

panels of Excentro Control inspector:
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◆ Show Type Details command switches on display of additional line with some

object attributes from Type panel of Excentro Control inspector, after that the

command title changes to Hide Type Details and choosing it again will restore

original rectangle view.

◆ Show Transform Details command switches on display of additional line

with object attributes from Transform panel of Excentro Control inspector,

after that the command title changes to Hide Transform Details and choosing

it again will restore original rectangle view. Additional line with Transform

details has small ‘coordinates system’ icon in front of it.

You can choose both Show Type Details and Show Transform Details options

to display two additional lines in object rectangle.

■ ‘Light bulb’ icon in right top corner of the rectangle shows if path of the object is visi-

ble in document preview window and gets exported to Adobe Illustrator format.

You can click this icon to switch on or off object path visibility. It has same effect as

clicking Visible checkbox in Path panel of Excentro Control inspector, but in this

case you you do not have to select the object first.

■ Color space icon and color patch in left bottom corner of object’s rectangle display

color attributes of the object set in color fields of Path panel of Excentro Control

inspector. By color space icon you can tell if current object color is RGB, CMYK or

Grayscale and if it is Spot or Process color. Spot colors have round icons, process col-

ors have square icons:
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You can double-click color patch with mouse pointer to set the object color as current

color of Color Mixer inspector.

■ Additional ‘pile’ icon is displayed in right top corner of object’s rectangle if the object

has Step & Repeat Set. This way you can identify objects with Step & Repeat Sets faster.

■ One more icon in right bottom corner helps to identify elements that has attributes

like Frequency Modulation or Symmetry in FX panel of Excentro Control inspec-

tor:

OBJECTS SELECTION

Before you will be able to make any operations with guilloche object, you have to select

this object first. To do so, click object’s rectangle with mouse pointer. Selected object is

shown with blue color in structure pane of main document window. Attributes of

selected object are displayed and could be modified in Excentro Control inspector.

Some operations like creation of content elements or changing parent objects require

you to select two guilloche objects at once. Click first object with mouse pointer, then

press Shift key on keyboard and click second object. Second selected object will be

shown with red color.
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CREATING OBJECTS

To add new objects to document structure tree you can use either commands  from

Structure menu or shortcut buttons to these commands from Excentro Toolbar. 

■ The first step of every guilloche design process is the creation of new root elements of

structure tree. To create new root elements (these elements are called bases in Excentro
terminology) you should use New Base command from Structure menu or its shortcut

button in Structure section of Toolbar. After that new base element of Ellipse type

will be created. You can change type of base element and modify its attributes in Excen-

tro Control inspector.

■ To create new regular element of structure tree you should select some existing object

that will become parent element of new element with mouse click and then choose

New Element command from Structure menu or its shortcut button in Structure

section of Toolbar. New element of Sine Wave type will be created. You can change

type of this new element or modify its attributes using panels of Excentro Control

inspector.
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■ To create new content element you should select two existing objects of structure tree

that will become parent elements of new element. First object should be selected with

unmodified mouse click, the object will become parent element or base of new content

element. Second object should be selected with Shift modifier key pressed on keyboard,

this object will become second parent object or second base of new content element.

After two objects are selected use New Element command from Structure menu or its

shortcut button in Structure section of Toolbar. New content element of Sine Wave

type will be created. You can change type of this new element or modify its attributes

using panels of Excentro Control inspector.

■ You can create new objects by duplicating existing ones. To do so you should select the

object you want to duplicate, then use Duplicate Element command from Structure

menu or its shortcut button in Structure section of Toolbar. A copy of the object will

be created and added to right end of same branch of structure tree. All attributes values,

Step&Repeat sets and connections to parent elements and direction elements will be

duplicated.
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If selected element has child elements, these elements will not be duplicated by

Duplicate Element command. If you want to duplicate child elements too (and all

their child elements), you should press Shift modifier key: Duplicate Element com-

mand of Structure menu will change its title to Duplicate All Elements and choos-

ing it will duplicate not only selected element but all its children elements too. All attrib-

utes values, Step&Repeat sets and connections to parent elements and direction ele-

ments will be duplicated.

■ Another way to make a copy of existing object is to use standard copy commands

from Edit menu. Select the object you want to make a copy of, then choose Copy or

Cut command to place a copy of this object to Excentro clipboard. After that select

another object you want to become parent element of new object and choose Paste

command to create new object. If you are copying content element, select not one but

two objects at once: one with plain mouse click, another with Shift-click.

■ There is a drag-and-drop action that could be used as a shortcut to copy-paste editing

sequence mentioned above: select the object you want to make a copy of with mouse

click in its rectangle in structure pane, then drag it with Option modifier key pressed on

the keyboard to rectangle of another object you want to become a parent of newly cre-

ated object. Mouse pointer will change its shape to ‘copy cursor’: an arrow with ‘plus’

(‘+’) sign below. Release mouse button and new copy of the object will be created.
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DELETING OBJECTS

■ To delete selected object of structure tree you can use Delete Element command

from Structure menu or its shortcut button in Structure section of Toolbar.

■ If selected element has child elements, this object can not be deleted by Delete Ele-

ment command. You can delete this element together with its child elements (and all

their child elements) with Delete All Elements command, to use this command press

Shift modifier key and Delete Element command will change its title to Delete All

Elements.

■ As another option you can use Cut and Clear commands from Edit menu to delete

selected object. Clear command is identical to Delete Element command in effect.

Cut command also places copy of deleted object to Excentro clipboard.

In all cases of objects deletion selected object (or its children in case of Delete All

Elements command) must not have any other objects dependent on it. See Chapter 3:

Structure Menu of Excentro Commands Reference for illustrations and more details.
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CHANGING OBJECT BASES

■ To change parent object of selected object you can select second object (that will

become new parent object of selected one) with Shift-click then choose Change Base

command from Structure menu or its shortcut button in Toolbar.

You can achieve same result with simple drag-and-drop action: drag selected object to

rectangle that represents new parent object in structure pane and release mouse button.

■ Content elements have two bases (two parent elements). First base of content ele-

ment could be changed just like base of regular element with Change Base command.

To change second base of content element you can use similar procedure with Change

Second Base command: select content element with mouse click, then select second

object (that will become new second parent of content element) with Shift-click and

choose Change Second Base command from Structure menu or its Toolbar button.
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■ You can also exchange parent element (base) and second parent element (second

base) of selected content element. Use Swap Bases command from Structure menu to

do so. Structure tree will be updated to reflect the change.

CHANGING ELEMENTS ORDER

If an element have several child elements you can rearrange their positions on branch of

structure tree using Elements Order submenu.

■ Set as First command sets selected element as first (leftmost) element of its parent.

■ Move Up command moves selected element one position left, so it changes places

with its left neighbor.

■ Move Down command moves selected element one position right, so it changes

places with its right neighbor.

■ Set as Last command sets selected element as last (rightmost) element of its parent.
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SETTING DIRECTION ELEMENTS

■ To appoint another element as direction element for selected one you can select this

element with Shift modifier key pressed on keyboard and choose Set command of

Direction submenu from Structure menu or click its shortcut button in Structure

section of Toolbar. Green connection line will appear between these elements.

■ To restore object direction element to its base element use Restore command of

Direction submenu from Structure menu or click its shortcut button in Structure

section of Toolbar. Green connection line between two elements will disappear.

Paths of direction elements are used to guide paths of the objects they are assigned to.

See Chapter 2: Basic Conceptions of Using Excentro guide for mechanics details

and explanations and Chapter 3: Structure Menu of Excentro Commands Refer-

ence for illustrations and more details on commands of Direction submenu.
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CHANGING OBJECT VISIBILITY

As was mentioned before ‘light bulb’ icon in right top corner of object’s rectangle shows

if path of the object is visible in document preview window and gets exported to Adobe
Illustrator format. You can click this icon to switch on or off object path visibility. It has

same effect as clicking Visible checkbox in Path panel of Excentro Control inspec-

tor, but in this case you you do not have to select the object first.

SETTING OBJECT COLOR

The last but not the least in frequency of use action you can perform with objects in

structure pane is setting objects color attribute. To do so, drag color patch from any

appropriate source like color well of Color Mixer, list view or swatch view of swatch

palette windows, color well of Excentro Control inspector or swatch list of Excentro
document to rectangular representation of the object in structure pane. This action has

same effect as dragging color patch to color well of Excentro Control inspector, but

does not require to select the object first.
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B: LAYERS LIST

Excentro documents may have several layers. Layers in Excentro serve same purpose as

layers in Adobe Illustrator, Macromedia FreeHand or other graphics applications: they

help you to split your guilloche design into several parts and work with each part inde-

pendently. For example, you may have in single document one layer with guilloche

background, another layer with borders, third layer with central rosette and few more

layers with additional guilloche elements. While you work with any of these layers, only

objects that belong to this layer are shown in structure pane of main document win-

dow. Objects on different layers are not shown in structure pane, visibility of paths of

objects on other layers in document preview window can be switched off too, so they

will not confuse you. 

You can duplicate whole layer content, delete layer or copy layer from document to doc-

ument with single simple actions. You may create several versions of your design ele-

ments on different layers of same document and decide which versions and layers you

want to include in final export Adobe Illustrator format document right before export

operation without deleting other layers beforehand. Excentro layers map directly to

Adobe Illustrator layers when exported and have similar attributes.

Excentro shows document layers in layers list of main document window. This win-

dow pane shows list of all document layers with their names and attributes. It also shows

list of objects on every layer in front-to-back drawing order and allows you to change

this order by dragging rectangle representations of the objects.

To manage document layers you can use commands of layers list menu (button with tri-

angle in top right corner of layers list). These commands let you create new layers,

merge, delete or duplicate existing ones.
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LAYERS REPRESENTATION AND OPTIONS

Document layers are shown as large rectangles in layers list. These rectangles show layer

graphics preview, layer name and display options:

■ ‘Light bulb’ icon in right top corner of layer rectangle shows visible attribute of the

layer. If ‘light bulb’ icon is displayed, then paths of objects on this layer are visible in doc-

ument preview window, if ‘light bulb’ icon is not shown, then paths of objects on this

layer are not visible.

You can click this icon to switch layer visibility on or off. For example, while working on

guilloche design on one document layer you can switch visibility of all other layers off,

so their paths will not intersect or overlap paths of objects you are changing at this

moment in document preview window.

Layer ‘rosette’ is visible Layer ‘rosette’ is not visible

By default invisible layers are not included in exported document in Adobe Illustrator
format. To override this behavior you can switch on Include Invisible Layers check-

box in Export panel of Excentro Preferences dialog. In this case invisible layers will

be exported in Adobe Illustrator format and will become similar invisible layers in Adobe
Illustrator.

■ Square icon below ‘light bulb’ icon can be either ‘black square’ or ‘empty square’. In

first case this layer is in preview mode and paths of its objects are shown with realistic

stroke weight and color in document preview window, in second case the layer is in

wireframe mode and paths of objects on this layer are shown as skeleton 1 pixel black

paths regardless of their actual stroke weight and color attributes.

.
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You can click this icon to toggle preview and wireframe display modes of the layer. For

example, when you are setting stroke weight and color attributes for objects on some

layer of the document, you can choose to toggle all other layers to wireframe mode and

get better illustration of what paths belong to that layer without hiding other layers

completely.

Both layers are in preview mode Layer ‘rosette’ is in wireframe mode

Layers preview and wireframe display modes are used only when the document itself is

in preview mode. When the document is in wireframe mode all paths on all of its layers

are shown as 1 pixel black. Document wireframe or preview modes selection is con-

trolled by Wireframe/Preview command from View menu of Excentro menu bar.

■ If you will click disclosure triangle button in left bottom corner of layer’s rectangle, the

layer will expand to show list of all objects it contains. The objects will be shown in

front-to-back drawing order below their layer’s rectangle in layers list.

Both layers are collapsed Layer ‘rosette’ is expanded

You can use object rectangles in the list to select objects in this layer, to change visibility

attribute of their paths and to rearrange their drawing order. If you will click disclosure

triangle button again content of this layer will become collapsed and its objects hidden.
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■ You can double-click string with name of the layer in layer’s rectangle to edit it. When

new layers are created Excentro by default names them in order of their creation as

‘Layer 1’, ‘Layer 2’, ‘Layer 3’, etc. You are not required to change these names, but assign-

ing more meaningful names like ‘Background’ or ‘Central rosette’ can help you to identify

proper layers more quickly in document layers list.

.

■ Two color patches in bottom part of layer’s rectangle show colors used for paths selec-

tion in document preview window. Left patch shows color used to display main path of

selected object, right patch is used to display additional paths that belong to Step &

Repeat Sets (if selected object has any Step & Repeat Sets).

.

Each layer may have its own set of two colors used to show selected paths. To change

these colors you can drag color patch from any color source: color well of Color Mixer

inspector, color well of Excentro Control inspector, swatch palette window or docu-

ment colors list to these patches in layer rectangle.

.

You can find setting different colors to different layers helpful if you would like to check

visually if document selection belongs to this or that layer. You can set same color value

to both colors used for paths selection. In this case main path and paths of Step &

Repeat Sets will be displayed with same color in preview window.
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Selection color used for main object path will be exported as selection color for that

layer, when you export job in Adobe Illustrator format at the end of your work.

To set one of selection colors as current color of Color Mixer inspector you can double-

click its color patch in layer’s rectangle.

OBJECTS REPRESENTATION IN LAYERS LIST

When you expand layer’s content by clicking disclosure triangle in left bottom corner of

the layer’s rectangle, list of guilloche objects on this layer becomes visible. Each guilloche

object is represented by small rectangle that shows its path preview, object type and gen-

eral attributes.

You can use object rectangles in the list to select objects in this layer, to change visibility

and color attributes of their paths and to rearrange their drawing order. 

Icons and attributes of objects rectangles are similar to those in objects rectangular rep-

resentation in structure pane, but object’s rectangle in layers list shows fewer fields to

make this view more compact and suitable for list usage.

Object in layers list Object in structure pane

■ ‘Light bulb’ icon in right top corner of object rectangle is the only ‘clickable’ area. It

shows if path of the object is visible in document preview window and gets exported to

Adobe Illustrator format.

You can click this icon to switch on or off object path visibility. It has same effect as

clicking similar icon in object’s rectangle in structure pane or clicking Visible checkbox

in Path panel of Excentro Control inspector.

LAYERS AND OBJECTS SELECTION

Selected layer in layers list has structure tree of its objects shown in structure pane of

main document window, so you could work with it as described in previous section

about structure pane. To select layer you want to work with click its rectangle in layers

list. Selected layer rectangle is shown with blue color in layers list.
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You can also use layers list to select guilloche objects in similar way like you would do it

in structure pane. To select object click its rectangle with mouse pointer. To select sec-

ond object for some operations like creation of content elements, press Shift key before

clicking its rectangle with mouse. Selected object is shown with blue color in layers list,

second selected object is shown with red color. Attributes of selected object are dis-

played and could be modified in Excentro Control inspector.

If you click object that belongs to layer that is not currently selected, layers selection will

be changed as well and content of the layer shown in structure pane.

CREATING LAYERS

■ To add new layer to document choose New Layer command from layers list menu

(button with triangle in top right corner of layers list). New layer will be inserted before

currently selected one in layers list. It will become selected layer, but since it contains no

objects structure pane will be clear. Now you can start adding guilloche objects to this

layer using commands from Structure menu. Excentro automatically assigns names to

new layers that reflect order of their creation: ‘Layer 1’, ‘Layer 2’, etc. You can change

layer name to more convenient one by double-clicking name string in layer’s rectangle.
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■ You can create new layers by duplicating existing layers in the list. To duplicate select-

ed layer choose Duplicate Layer command from layers list menu. New copy of the

layer will be inserted before selected layer in the list. This layer will have identical struc-

ture tree with all objects and attributes of selected layer duplicated. Newly created layer

will be selected in the list after the operation. Name of the layer will have ‘copy’ word

added to the name of original layer. You can change the layer name to more convenient

one by double-clicking name string in layer’s rectangle.

Title of Duplicate Layer command reflects selected layer name, so you can make

another check that proper layer is selected before choosing this command.

■ You can also create new layers by copying them from another document. To do so,

drag layer’s rectangle from layers list of source document to layers list of destination

document. Release mouse button and new copy of dragged layer with all objects and

attributes will be created at destination.

DELETING LAYERS

To delete selected layer from document choose Delete Layer command from layers list

menu (button with triangle in top right corner of layers list). The layer and all objects it

contains will be deleted (see picture on next page). Next layer in the list will be automat-

ically selected after the operation. You can undo layers deletion later, if you change your

mind or deleted wrong layer by mistake.
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Title of Delete Layer command reflects selected layer name, so you can make another

check that proper layer is selected before choosing this command.

MERGING LAYERS

■ You can merge contents of selected layer and layer below it in layers list using Merge

Layers command from layers list menu. Objects that belong to layer below selected one

will be moved to selected layer and empty layer below will be removed from document.

If there is no layer below the selected one, content of selected layer will be merged this

command with content of the layer above.

Title of Merge Layers command contains names of layers that will be merged, so you

can make another check that proper layer is selected before choosing this command.

■ You can merge contents of all layers in document layers list using single Merge All

Layers command from layers list menu. Objects that belong to other layers will be

moved to selected layer and empty layers will be removed from document.
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REARRANGING LAYERS AND OBJECTS ORDER

■ The order of layers in the lists corresponds to layers front-to-back drawing order:

paths of objects that belong to layers at top appear above paths of objects that belong to

layers below them. You can rearrange this order by dragging layers rectangles with

mouse. Drag selected layer rectangle to desired position in the list, release mouse button

and layers order will be updated accordingly as well as graphics in document preview

window .

■ In similar way you can rearrange front-to-back drawing order of objects on each layer.

Click disclosure triangle in left bottom corner of layer’s rectangle to expand layer’s con-

tent, then select object you want to change front-to back order for with mouse click and

drag its rectangle to desired position in the list of this layer objects. Paths of objects

located below selected object in layers list appear below its path in document preview

window, paths of objects above selected object in layers list overlap its path in document

preview window. You can not move object to another layer by dragging its rectangle in

layers list.

Another way to rearrange front-to-back drawing order for objects is to use commands in

Arrange menu of Excentro menu bar. With these commands you can move object one

position up (Bring Forward) or down (Send Backward) or straight to the top (Bring

to Front) or bottom (Send to Back) of its layer objects list. See Chapter 4: Arrange

Menu of Excentro Commands Reference for more details and illustrations.
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C: COLORS LIST

Just like many others graphics design applications Excentro allows you to keep with doc-

ument set of colors used to colorize paths of this document objects. This set of colors is

displayed in colors list of main document window, it is saved with Excentro docu-

ment and gets exported with final design to Adobe Illustrator format file to be displayed

in Swatches palette of this application.

One of the reasons why managing document colors list is important is that guilloche

designs are often printed with fixed number of spot colors. So you can choose these col-

ors at the beginning of your work and later use only them for guilloche paths of your

design. By modifying color values of any of these colors in the list you can quickly

change color of all paths this list entry was used for.

To manage document colors you can use commands of colors list menu (button with tri-

angle in top right corner of colors list). These commands let you create new color

entries, delete or duplicate existing ones, convert process colors to spot colors.

Initially, when you create new Excentro document, its colors list is not empty. It contains

color entries from default swatch palette file. This could be:

■ Swatch palette file named ‘Default’ located in ‘Swatch Palettes ƒ’ folder that

could be found in same folder as Excentro application. This is Excentro document

that gets copied to this location when you install Excentro application. Later you

can edit this file, so that it contains colors that you use most frequently in your

designs.

■ Any other swatch palette file with Use as Default option checked in its win-

dow menu.
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VIEW MODES

Document colors list may be presented in one of two view modes: List View or Swatch

View. You can switch between these modes by clicking buttons in top part of colors list

or by using colors list menu:

■ List View is the default view for colors list. This view mode shows color patch, color

name, and color system icon that also helps to identify this list entry as spot or process

color. Colors list entries are shown as rectangles in colors list.

◆ Small color patch rectangle gives you visual representation of color entry value.

You can use this patch to change color value of this entry by dragging color patch

from any area that could serve as color source: color well of Color Mixer, color

well of Excentro Control inspector, list view or swatch view area of swatch

palette window or colors list of another Excentro document to this small rectangle.
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If name of the color entry was created automatically after adding this color from

Color Mixer it will be changed together with its color value (if new name will be

still a unique name in the colors list). All objects in Excentro document that were

assigned this color value will have their color attributes updated to new one as

well.

◆ You can double-click string with name of color entry to edit it. When new color

entries are created by adding colors to the list from Color Mixer, Excentro by

default creates their names from numeric attributes of the color, e.g. C:0 M:79:
Y:91 K:0 if color is in CMYK color space, R:196 G:35 B:39 if color is in RGB color

space, K:63 if color is in Grayscale color space, or 42% PANTONE 101 CVC if color

is a tint percentage of Spot Color. You can edit these names to make them more

meaningful for your work.

◆ Icons on right side of list entry rectangle show color space of the entry: RGB,

CMYK or Grayscale and if it is Spot or Process color. Spot colors have round

icons, process colors have square icons.

■ Swatch View. This view mode shows only color patches of list entries that show visu-

al representation of their color values. This mode gives you more compact view of colors

list, that makes sense if your document has many entries in its color list.

As it is with List View mode, you can use color patches to change color value of list

entry by dragging color patch from any area that could serve as color source: color well
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of Color Mixer, color well of Excentro Control inspector, list view or swatch view

area of swatch palette window or colors list of another Excentro document to this small

rectangle.

If name of the color entry was created automatically after adding this color from Color

Mixer it will be changed together with its color value (if new name will be still a unique

name in the colors list). All objects in Excentro document that were assigned this color

value will have their color attributes updated as well.

CREATING COLORS

You can add new color entries to document colors list in number of ways:

■ The most practical way to add new color entry is to drag color patch from any area

that could serve as color source: color well of Color Mixer, color well of Excentro

Control inspector, list view or swatch view area of swatch palette window or colors list

of another Excentro document to colors list of main document window. Drop color

patch in list area and new entry will be created at this location. Be careful not to drop

color patch on color patch rectangle of existing colors list entry — this is the way to

change color of this entry, not to create new one.
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■ Another way to add to the list new entry with current Color Mixer color value is to

use New Swatch command from colors list menu. New color entry will be created

above current selection in the list. As was mentioned above, name for this entry will be

created from numeric attributes of the color. You can edit the name to make it more

meaningful for your work

■ You can also create new entries in the list by duplicating existing ones. Select color list

entry you want to duplicate with mouse click and choose Duplicate Swatch command

from colors list menu. New entry will be inserted in the list above current selection. This

entry will have same color value as selected entry. Word ‘copy’ will be added to its name,

you can change the entry name to more convenient one by double-clicking name string

in its rectangle.

Title of Duplicate Swatch command shows name of selected colors list entry, so you

could make another check that proper entry is selected before choosing this command.

■ If you assigned color attributes to objects by dragging color patches to objects repre-

sentations in structure pane or layers list directly from color well of Color Mixer or

swatch palette windows, or if you copied objects and layers from other documents with

colors lists different from that of current document, you can later add all colors used to

colorize objects paths in this document to colors list with help of Add All Used com-

mand from colors list menu. When you choose this command Excentro will compare

color attributes of all objects in the document with entries in its colors list and if it will

find any objects with color values missing from colors list it will add new entries to the

list with these values. New entries will be added to the end of the colors list. Add All

Used Spots command is special version of Add All Used command that works only

with spot colors. It adds to document colors list missing spot color entries. If document

has any objects that use process colors missing from colors list, these colors will not be

added by this command.
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DELETING COLORS

■ To delete selected swatch from swatches list choose Delete Swatch command from

swatches list menu (button with triangle in top right corner of the list). The swatch will

be deleted.

Title of Delete Swatch command shows name of selected swatch, so you can make

another check that proper swatch is selected before choosing this command.

■ You can also clean up swatches list by deleting all swatches that are not used to col-

orize paths of objects in this document. Choose Delete All Unused command from

swatches list menu and all unused swatches will be deleted.
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MAKING SPOT AND PROCESS COLORS

Colors list of main document window is the place where you can convert process

colors to spot colors and back again. You can accomplish this task with Make Spot and

Make Process commands from colors list menu.

■ To convert selected process color to spot color choose Make Spot command from

colors list menu. Square color space icon (if colors list is in List View mode) will be

replaced by round color space icon that identifies spot colors. If you double click select-

ed color in the list after this operation Color Mixer will show this color as spot color

with single T slider that allows you to set tint percentage of spot color.

■ Make Process command is the opposite of Make Spot command. To convert select-

ed spot color to process color you can choose Make Process command from colors list

menu. Round color space icon (if colors list is in List View mode) will be replaced by

square color space icon that represents spot colors. If you double click selected color in

the list after this operation Color Mixer will show this color as a process color in

appropriate color space panel (CMYK, RGB or Grayscale).
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FIND CLOSEST SWATCH

You can use Find Closest Swatch command from colors list menu to select the color

entry in the list with closest color values to current Color Mixer color. This command is

available only when color management is switched on with Use ColorSync™ checkbox

in Color panel of Excentro Preferences dialog. Colors are compared using ∆E values

of their coordinates in Lab color space. Results might differ depending on current

ColorSync profiles preferences.

SETTING CURRENT COLOR MIXER COLOR

To inspect color values in document colors list before applying them to objects or to mix

a tint of spot color you may want to set color of selected entry in the list as current color

of Color Mixer. To do that you can either double click selected entry in the list or drag

its color patch to color well of Color Mixer as shown by arrow on picture below.

If Color Mixer window was closed before you double clicked a color entry in colors list,

it will reappear on screen in the same location it was shown last it time it was used. If

Color Mixer window was collapsed to color space titles and icons bar it will be restored

to normal size. Proper color space panel: CMYK, RGB, Grayscale or Spot Color will be

selected to show color values.
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APPLYING COLOR TO OBJECTS

Assignment of color attributes to objects in Excentro should be performed with explicit

drag-and-drop actions. This way you do not have to disselect objects just to explore con-

tents of colors lists or experiment with color sliders in Color Mixer. To apply color from

colors list of main document window to object you can do one of the following:

■ Drag color patch from the colors list to rectangle that represents the object in

structure pane or layers list. This way you can change color of objects without

selecting them first. It could be more comfortable method if you want to set same

color to more than one object without changing current selection.

■ Select the object you want to change color of in main document window or

preview document window, then open Path panel of Excentro Control inspec-

tor and drag color patch from the colors list to color well of Excentro Control.

Assignment of color with drag-and-drop actions is used not only for colors from the col-

ors list of main document window, but also for colors from Color Mixer and

Swatch palette windows. Just drop color patch you want on object in document win-

dow or color well in Excentro Control inspector to set this value to the object.
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CHAPTER 4: DOCUMENT PREVIEW WINDOW

Each Excentro document has two windows to display its content: main document

window that shows document structure, layers list and colors list and document pre-

view window that shows graphics representation of guilloche design. Document pre-

view window has <view> suffix added to document name in its title bar and is usually

located in right part of the screen.

Graphics display in document preview window is similar to what you will see in vec-

tor drawing applications like Adobe Illustrator after finished guilloche will be exported

with Export command from File menu. Like windows of Adobe Illustrator document

preview window shows document graphics content and page size area, contains posi-

tioning grid and rulers, displays paths of current selected object and supports different

preview modes like Preview or Wireframe. 

Unlike Adobe Illustrator and other vector drawing applications, Excentro does not allow

direct manipulations with graphics in document preview window like moving spline

control points with mouse pointer. To avoid loss of precision the only way to edit guil-

loche paths is through changing their objects attributes in numeric fields of Excentro

Control inspector or controls and slider of Property Inspector window. Actions you

can perform in document preview window are limited to scrolling, zooming and

selecting.

Excentro menu bar has View menu that controls graphics magnification and view

options of document preview window. To change magnification of guilloche graph-

ics you can also use shortcut buttons in Document Zoom section of Toolbar. Tools

section of Toolbar hosts four tools you can use to perform different actions in preview

window: Selection Tool, Zoom Tool, Measure Tool and Hand Tool.

Excentro Windows Reference

Chapter 4: Document Preview Window

4-1



PREVIEW WINDOW CONTENTS

Document preview window displays document guilloche graphics and has several

special areas that makes this display easier to read and use:

1. Tools information area is located in top part of document preview window

below window’s title bar. This narrow area contains single line with four informational

fields: X, Y, ∆∆ and °. You can look at these fields while you are positioning and sizing

graphics objects to get more accurate results.

X and Y fields values change together with mouse pointer movements in docu-

ment preview window. They show current mouse pointer position in coordi-

nates system used for guilloche graphics preview.

∆∆ and ° fields values are active only when you selected Measure Tool in Toolbar.

These values show current distance and angle between starting point and end

point of measuring line in coordinates system of guilloche graphics preview
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2. Document page border is a thin rectangle that limits document page size area. You

can define document page size when you create new Excentro document with New

command from File menu or you can change it later with Document Setup… com-

mand from File menu. Document page size helps to visually limit work area for your

design. It is used also with zoom commands Fit Page and Fit Width to calculate new

magnification values.

3. Paths of selected object in Excentro document is shown with two special colors in

document preview window. First color is used for main path of the object, second

color shows additional paths that belong to Step & Repeat Sets (if selected object has

any Step & Repeat Sets).

These colors are defined and can be changed in layers list of main document window.

Each layer may have its own set of two colors used to show selected paths. You can find

setting different colors to different layers helpful if you would like to check visually if

document selection belongs to this or that layer.

You can set same color value to both colors used for paths selection. In this case main

path and paths of Step & Repeat Sets will be displayed with same color in preview win-

dow.

Selection color used for main object path will be exported as selection color for that

layer, when you export job in Adobe Illustrator format at the end of your work.

4. Grid is a set of vertical and horizontal lines with center in the center of coordinates

system used for graphics preview. It is another element of document preview win-

dow that simplifies positioning and sizing of graphics objects. Grid size and color can be

changed in Document Grid section of General panel in Excentro Preferences dia-

log. To change grid visibility you can use Show Grid and Hide Grid commands from

View menu.

5. Excentro shows two Rulers in document preview window: horizontal ruler in bot-

tom part of the window and vertical ruler in right part. As all other elements of docu-

ment preview window rulers help to position and size graphics objects with more

accuracy. Rulers use application-wide measurement units selected in General pop-up

menu of General panel in Excentro Preferences dialog. ‘Zero’ rulers position corre-

sponds to the center of coordinates system used for guilloche graphics preview.
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PREVIEW MODES

Document preview window can show guilloche graphics in one of two modes:

Wireframe mode or Preview mode. You can toggle between these modes with

Wireframe/Preview command of View menu.

■ Preview mode shows realistic graphics preview with actual path colors and stroke

weights at selected window magnification value.

■ Wireframe skeleton mode shows all visible graphics of the document as uniformly 1

pixel black paths.
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■ Besides the document preview mode that you can control with commands from View

menu, each layer of Excentro document may have its own preview mode that could be

changed with mouse click on layer mode icon. Layers may also be in one of two modes:

realistic preview mode that shows actual path colors and stroke weights (indicated with

small black rectangle) or wireframe mode that shows skeleton 1 pixel black paths (indi-

cated with small empty rectangle). Layers modes are used only when the document is in

preview mode. When the document is in wireframe mode all paths are shown as 1 pixel

black regardless of preview mode of the layer they belong to.

Comments: You can use preview and wireframe modes on different stages of guilloche
design process: when you create basic guilloche geometry wireframe mode can give better
illustration of paths shape and intersections, alternatively, when you specify colors and
stroke thickness at final steps of guilloche creation, preview mode shows the actual picture.
Wireframe mode is a faster mode, because it gives fewer graphics details, so if you are
working on complex design you can switch to this mode to save some time on graphics
updates in preview window.

NODES PREVIEW

You can use Show Nodes/Hide Nodes command from View menu to turn on and off

preview of ‘path nodes’ — small dots that show joints of spline segments guilloche path

consists of. Visible nodes give you overview of vector paths as they will be exported in

Adobe Illustrator format. Experienced user can use this preview to avoid occasional paths

generation defects like loops or corners that sometimes can result from certain prob-

lematic object attributes combination.

If document and layer are in realistic preview mode (mode that shows colors and stroke

weights of guilloche paths) you can see only nodes of paths that belong to selected

object and its step & repeat set (see pictures on next page).
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Guilloche graphics in preview mode Same guilloche with visible nodes

When document or layer are in wireframe mode (mode that shows all paths as skeleton

1 pixel black graphics) nodes of all visible paths are shown at once.

Guilloche graphics in wireframe mode Same guilloche with visible nodes

Comments: Number of nodes the path of selected object consists of is shown in bottom
area of Path panel of Excentro Control inspector. You can not manually specify this
value or edit individual spline segments in Excentro. All guilloche paths creation issues are
indirectly controlled by object attributes and its place in objects hierarchy. If you want, you
can edit spline segments and nodes of the paths in any vector-based illustration design
package later, after guilloche graphics is exported in Adobe Illustrator format.
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ACTIONS IN PREVIEW WINDOW

■ Objects selection. One of primary tasks you can do in document preview win-

dow is document objects selection. Make sure that Selection Tool is the currently

selected tool of Toolbar. If it is not, you can temporarily switch to Selection Tool by

pressing down Command key.

Cursor shape for Selection Tool is standard ‘Arrow’ cursor. To select object of Excentro
document click with mouse pointer path that belongs to this object. The object will

become selected and will be shown in document preview window with special selec-

tion colors. As was mentioned above Excentro uses two colors to show paths of selected

objects: first color is used for main path of the object, second color shows additional

paths that belong to Step & Repeat Sets (if selected object has any Step & Repeat Sets).

■ Measurements. To measure distance and angles between two points in document

preview window you should select Measure Tool in Toolbar.

Cursor shape when Measure Tool is selected changes to standard ‘Cross’ cursor. Click

first point and holding down mouse button drag cursor to second point you want to

measure distance to. To lock measure directions to 45° angles (0°, 45°, 90°, 135°, …) hold

down Shift key. Measurement information is shown in tools information area in top

part of document preview window.

■ Scrolling. Scrolling contents of document preview window could be done in

same way as in any other graphics application. You can do it with two windows scroll

bars or with Hand Tool. If Hand Tool is not currently selected tool of Toolbar you can

temporarily switch to it by pressing and holding down Space key.

Cursor shape for Hand Tool is standard ‘Hand’ cursor. Press mouse button somewhere

within document preview window and holding the button down drag mouse cursor

in the direction you want window contents to be scrolled. Graphics content of the win-

dow will be updated as you drag to show newly exposed areas.
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■ Zoom. To enlarge parts of document preview window you can use Zoom Tool. If

it is not currently selected tool of Toolbar, you can temporarily switch to Zoom Tool

by pressing down Command-Space key combination.

Cursor shape for Zoom Tool is standard ‘Magnifier Lens’ cursor. Press mouse button

within document preview window and holding the button down drag mouse cursor

to select area you want to see enlarged. Release mouse button when you are ready and

magnification value of graphics preview will be changed. Pressing down Option key

you may switch between Zoom In and Zoom Out actions.

Another way to zoom content of document preview window is to use first six items

of View menu and their buttons shortcuts in Document Zoom section of Toolbar.

Document Zoom section also shows current magnification value graphics is dis-

played at.

• Actual Size command sets magnification value of document preview window

to 100%. This allows you to see graphics at its ‘real size’, not in zoomed in or

zoomed out state.

• Fit Page command calculates and sets new magnification value so that whole

page size of the document fits into preview window. You can use this command if

you want see overview of all document graphics content quickly.

• Fit Width command has similar effect to Fit Page command but it uses only

horizontal page size dimension (width of the document) to calculate and set new

magnification value. When you choose this command, document preview will be

scaled to fit width of the document into its preview window. After that you will be

able to see whole document content using only vertical scroll actions.

• Zoom In command selects next magnification value from predefined magnifi-

cation values list: 6.25%, 12.5%, 25%, 50%, 75%, 100%, 200%, 400%, 800%, 1600%,

3200%, 6400%.
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• Zoom Out command has opposite effect to Zoom In command: it selects pre-

vious magnification value from same predefined magnification values list.

• Zoom submenu allows you to explicitly select magnification value for preview

document window from the predefined list. Check mark will appear beside the

value after you selected it from the submenu. You can also use pop-up menu in

Document Zoom section of Excentro Toolbar with same values.

• Last Other… item of Zoom submenu calls up Zoom To dialog, where you can

type new desired magnification value in Magnification field.

Document Zoom section of Toolbar have similar magnification value field that

shows current magnification value and could be used instead of Zoom To dialog.

View Menu chapter of Excentro Commands Reference contains more information

about these commands and other commands of View menu with better illustrations.

Please, see it if you are interested in details.

OTHER OPTIONS

Let us mention two other options that you can find useful while working with docu-

ment preview window. These descriptions are copied from View Menu chapter of

Excentro Commands Reference and placed here so you will be able to find all infor-

mation about document preview window in single chapter.

■ Redraw command of View menu redraws visible guilloche paths in document

preview window. You can use this command if you believe that something is

wrong with display of document graphics, for example, if your display card drivers

do not work properly with present Mac OS version and you see unpleasant arti-

facts when you switch between windows and applications. Sometimes something

like that could be noticed when you use applications in Classic mode under Mac
OS X operation system — parts of the window that was overlapped by other win-

dows remain white after you selected it. With Redraw command you can force

redrawing of all visible area of preview document window.

■ Recalculate command of View menu recalculates all guilloche paths of cur-

rent document and draws visible paths to preview window as it calculates them

(the process is similar to what happens when you open Excentro document for the

first time and guilloche paths are created from document tree-like elements struc-

ture). You can use this commands if you believe that something is wrong with doc-

ument graphics and you want to check if it was properly calculated.
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CHAPTER 5: EXCENTRO CONTROL

Excentro Control is a ‘chief’ among Excentro inspectors. It is a core of application and

focus of most user actions because it controls all attributes and properties of selected

object in Excentro document window including graphic appearance attributes of its vec-

tor paths.

Excentro Control window floats above layer of Excentro document windows, just like

Toolbar and other inspector windows. If it is not on the screen you can summon it with

Excentro Control command from Inspectors submenu of Window menu or just by

double-clicking with mouse rectangular representation of the object you want to edit

attributes of in any pane of main document window.

Check mark appears beside Excentro Control command in Inspectors submenu

while Excentro Control window is on the screen. Selecting this command again will

hide the inspector.

Excentro Control window has four panels that group objects attributes according to

their purpose: Type, Transform, FX and Path. You can switch between these panels by

clicking icons and titles in top part of the window.
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■ Type panel controls general attributes that define shape of guilloche object path. 

■ Transform panel allows you to perform all sorts of geometric transformations with

guilloche object path like scaling, skewing, rotating and moving

■ FX panel allows you to apply special effects like Frequency Modulation or Symme-

try to guilloche objects of certain types. 

■ Path panel sets graphic appearance attributes of guilloche object path like stroke

weight, stroke color, types of end caps and joins of spline segment.

When none of these four panels is selected, Excentro Control window is ‘collapsed’

and panels content is hidden from view. This feature can be helpful to Mac OS X users

who miss ‘window shade’ feature of Mac OS 9. To expand the window to normal size,

select any panel by clicking its icon or title.

Length of Excentro Control window varies depending on if selected object has any

Step & Repeat Sets. Step & Repeat Sets represent very important to Excentro ability to

quickly create a set of additional paths by modifying one or more of object attributes.

Attribute modifications are specified by Increment fields located beside attribute fields

in expanded version of Excentro Control window.

All manipulations with Step & Repeat Sets: addition and deleting set to the object are

performed with commands from Excentro Control window menu (button with trian-

gle in top right corner of the window):
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After you add Step & Repeat Set to the object with Add Step & Repeat Set command,

Excentro Control window will expand to show Increment fields of new Set.

Every Excentro object may have more than one Step & Repeat Set. When you will add

second Step & Repeat Set, Excentro Control window will expand again to show list of

Step & Repeat Sets. You can use this list to select different Step & Repeat Sets or change

their order by dragging list items with mouse.

If later you will choose to delete Step & Repeat Sets, Excentro Control window will

shrink back again to its original size.

After this short introduction let us proceed to more detailed description of Excentro

Control window, all its panels and controls with illustrated descriptions of tasks you

can perform with them.
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OBJECT SELECTION

Excentro Control window shows attributes of selected object in Excentro document.

That means that before you will be able to change object attributes with Excentro

Control you should select this object with mouse click using one of two document win-

dows. If Excentro Control window was hidden you can use double-click instead of

single mouse click to select the object and bring Excentro Control window to screen

in one action.

When you create new object with New Base or New Element commands from

Structure menu, new object is automatically becomes selected object in the document

and its attributes are shown in Excentro Control window ready to be changed.

TYPE

You can switch to Type panel by clicking Type icon or title in top part of Excentro

Control window.

Type panel for ‘base’ object of Ellipse type.

This panel controls general attributes that define shape of the path for selected object.

This panel appearance and number of fields are specific to objects of certain type and

change when you select different type from Type pop-up menu in top left corner of the

panel. For this reason, we will not cover all fields and controls of Type panel in Excen-

tro Windows Reference book. Please, see Excentro Objects Reference for detailed

description of all Excentro object types and their specific attributes in Type panel.
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TRANSFORM

You can switch to Transform panel by clicking Transform icon or title in top part of

Excentro Control window.

This panel allows you to perform all sorts of geometric transformations to shape of path

that belongs to selected object like scaling, skewing, rotating or moving. Fields of this

panel are similar to that of Transform palette of Adobe Illustrator or Transform panel

of Macromedia Freehand. But you should keep in mind that transformations in Excentro
are attributes of the objects, not just occasional actions that modify vector path. That

means that there is always initial shape of object path in Excentro, the shape that is

uniquely defined by attributes in Type panel of Excentro Control window and place

of the object in guilloche structure tree. You can distort this initial shape by specifying

different values in fields of Transform panel, but you can always quickly restore the

original shape by changing these values back to zero (or 100% in case of Scale fields).

Let us note the order in which Excentro applies different transformation attributes to

object path. Because you will get different results if application would scale object shape

in horizontal direction and after that rotate it by 45°, or if it would rotate object shape by

45° first and then scale it in horizontal direction. To get always predictable results,

remember that the order of transformations in Excentro is the same as order of attributes

in Transform panel of Excentro Control window. That is: 

1. scaling

2. skewing

3. rotating

4. moving

Fields and controls of Transform panel:

■ Picture in top left corner of Transform panel provides small illustration of function

for selected attribute field. This picture changes as you move cursor through different

fields of Transform panel You can not click, drag or do anything with this field. It is

there for your information only.
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■ Scale H field allows you to apply horizontal scale transformation to path of selected

object. Value of 100% means ‘no transformation’. Values greater than 100% will enlarge

the object path in horizontal direction, values less than 100% will reduce it. Negative val-

ues will reflect (flip) the path horizontally. Stroke weight of the path will not be scaled

with horizontal scale transformation.

■ Scale V field allows you to apply vertical scale transformation to path of selected

object. Value of 100% means ‘no transformation’. Values greater than 100% will enlarge

the object path in vertical direction, values less than 100% will reduce it. Negative values

will reflect (flip) the path vertically. Stroke weight of the path will not be scaled with ver-

tical scale transformation.

■ Skew H field allows you to skew shape of selected object in horizontal direction.

Positive angles perform skewing to the right, negative angles perform skewing to the left.
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■ Skew V field allows you to skew shape of selected object in vertical direction. Positive

angles correspond to skewing up, negative angles correspond to skewing down.

■ Rotation field allows you to rotate path of selected object around Transform

Center point (see below). Positive angles rotate path in counterclockwise direction,

negative angles rotate path clockwise.

■ Move X field allows you to move path of selected object in horizontal direction.

Positive values move path to the right, negative values move path to the left. The value in

this field is shown in application-wide measurement units that could be configured in

General panel of Excentro Preferences dialog.
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■ Move Y field allows you to move path of selected object in vertical direction. Positive

values move path up, negative values move path down. The value in this field is shown

in application-wide measurement units.

■ Scaling, skewing and rotating transformations (that is all transformations, except for

moving) are performed in relation to a special point called Transform Center:

◆ By default this point is set by parent object of selected object, this way paths of

child objects are transformed together with path of their parent. In this case Base

is selected option in Transform Center pop-up menu.

◆ You can change this behavior and explicitly set coordinates of other point to be

used as Transform Center. To do so, select Other… option in Transform

Center pop-up menu and enter coordinates of desired point in X and Y fields

(these fields will become active). Coordinates are set in application-wide measure-

ment units that could be configured in General panel of Excentro Preferences

dialog. Picture below illustrates this option: same 10° rotating transformation as

illustrated on previous page now is performed relative to point with explicitly set

coordinates: X=30pt, Y=30pt.

Comments: ‘Transform Center point for transformations with Base option is initially
determined as center point of path that belongs to ‘base’ element of guilloche structure
(root object of structure tree) unless ‘base’ element is of Line type which has some addi-
tional options. Objects on next levels of structure tree can modify this point either by explic-
itly specifying other point with Other… option from Transform Center pop-up menu or
by offsetting this initial ‘Transform Center point by moving transformations with Move X
and Move Y attributes. Child elements of these objects will use this new modified
Transform Center for their transformations with Base option.
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FX

You can switch to FX panel by clicking FX icon or title in top part of Excentro

Control window.

This panel allows you to apply special effects like Frequency Modulation or Symme-

try to guilloche objects of certain types. These effects together with objects they can be

applied to are illustrated and discussed  in Excentro Objects Reference book.

PATH

You can switch to Path panel by clicking Path icon or title in top part of Excentro

Control window.

This panel allows you to set appearance attributes to guilloche path of selected object.

Unlike other panels of Excentro Control that control shape of the path through set of

object attributes and properties, this panel changes graphic appearance attributes of this

path like stroke weight, stroke color, end caps and joins types. Path panel attributes are

similar to that of Stroke and Attributes palettes of Adobe Illustrator and have even

more similarities to Stroke and Object inspectors of Macromedia Freehand.

■ Visible checkbox allows you to make path of selected object visible or invisible.

When this checkbox is ‘on’ the path is visible in document preview window and  ‘light

bulb’ icon appears in right top corner of its rectangular representation in panes of main

document window. When checkbox is ‘off’ the path is not visible and ‘light bulb’ icon

disappears.
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You can click ‘light bulb’ icon in structure pane or layers list of main document window

as another way to to toggle visible attribute of the object. This way you can make object

path visible or invisible without selecting this object first.

By default invisible paths are not included when you export your design to Adobe
Illustrator format. To override this behavior you can switch on Include Invisible Paths

checkbox in Export panel of Excentro Preferences dialog. In this case invisible paths

will be exported too, but they will not have stroke or fill attributes. You can set these

attributes later in Adobe Illustrator or use these paths as guides or clipping paths.

■ Stroke field allows you to specify stroke weight (‘line width’) attribute of the path.

This field shows value in stroke measurement units that could be configured in General

panel of Excentro Preferences dialog. In Stroke panel of Excentro Preferences

dialog you can set up list of stroke weight presets that will appear in Stroke pop-up

menu (arrow-down button beside Stroke field). These preset values are provided for

convenience: in most cases your documents will have paths of only three or four differ-

ent stroke weights (e.g. strokes of 0.25 pt are used for background paths, strokes of 0.5 pt

and 1.0 pt for everything else). It is faster to assign these values using pop-up menu

selection than by keyboard typing. Last Edit… item of Stroke pop-up menu brings to

screen Stroke panel of Excentro Preferences dialog where you can edit list of these

presets.

■ Overprint checkbox allows you to switch ‘on’ and ‘off’ overprint attribute for the

path of selected object. If overprint is ‘off’ area covered by the path including intersec-

tions with underlying paths will be erased (‘knocked out’) on separations different from
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path’s color (when output device will be producing color separations). If overprint is

‘on’, covered area will not be erased and printing device will print continuos path stroke

over any background that might be under it. By default overprint attribute is ‘on’ in

Excentro, because guilloche paths are very fine, they are usually printed with spot colors

and may have many intersections. All these can cause registration problems at print time

that could be avoided by switching overprint attribute ‘on’.

■ Cap selectors allows you to choose type of end cap to be drawn at the end of open

paths. These three end cap types are same as in any vector drawing application:

◆ But Cap. The stroke is squared at the endpoint with no projection beyond it.

◆ Round Cap. A semicircle is drawn at the endpoint with diameter equal to

stroke weight of the path.

◆ Projecting Cap. Square stroke continues beyond the endpoint for a distance

equal to half of stroke weight of the path.

■ Join selectors allows you to choose type of spline segments joins. These three join

types are same as in any vector drawing application:

◆ Miter Join. Outer edges of spline segments are extended until they meet. If the

angle is sharper than value controlled by Miter Limit attribute (see below) than

join of Bevel Join type is used instead.

◆ Round Join. A circular arc with diameter equal to stroke weight of the path is

drawn at the point where spline segments meet.

◆ Bevel Join. Ends of spline segments are connected by line segment and filled.
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■ Miter Limit field allows you to specify ratio of miter join length to stroke weight at

which spline segments joins of Miter Join type will be replaced by joins of Bevel Join

type. This value should be between 1 (this is the value when all Miter Joins are replaced

by Bevel Joins) and 500. Miter Limit field has pop-up menu beside it with common

ratio presets:

◆ 11.4737 (10°). At this value Excentro switches from Miter Join to Bevel Join if

spline segments meet at angle sharper than 10°. You probably should not set Miter

Limit value greater than that.

◆ 10 (PostScript). At this value Excentro switches from Miter Join to Bevel

Join if miter join length is 10 times longer than stroke weight. This is default value

used by many PostScript RIPs.

◆ 5.7588 (20°). At this value Excentro switches from Miter Join to Bevel Join if

spline segments meet at angle sharper than 20°.

◆ 4 (Illustrator). At this value Excentro switches from Miter Join to Bevel Join

if miter join length is 4 times longer than stroke weight. This is default value used

by Adobe Illustrator application.

◆ 3.8637 (30°/FreeHand). At this value Excentro switches from Miter Join to

Bevel Join if spline segments meet at angle sharper than 30°. This is default value

used by Macromedia FreeHand application.

◆ 2.6131 (45°). At this value Excentro switches from Miter Join to Bevel Join if

spline segments meet at angle sharper than 45°.

◆ 2 (60°). At this value Excentro switches from Miter Join to Bevel Join if spline

segments meet at angle sharper than 60°.

◆ 1.4142 (90°). At this value Excentro switches from Miter Join to Bevel Join if

spline segments meet at any sharp angle, that is if angle is sharper than right angle

of 90°.

■ Closed pop-up menu lets you to force closing of open paths by adding missing spline

segments. This menu has three options: Auto, Yes, No.

Auto is the default option. In this case Excentro automatically closes all paths if their

endpoints meets and do not close paths when endpoints are located at some distance

one from another. Information string beside the pop-up menu informs you about the

result: (Yes) (path was closed) or (No) (path is open). In most cases this is sufficient for

to get good results. 
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Sometimes object attributes combinations may result in not coinciding beginning and

ending points of guilloche path and, if Auto option is active, this path will remain open

while by design intents it should be closed. In such cases you can use Yes option of

Closed pop-up menu to add extra spline segment and force closing of the path.

Let us look at some typical example. We have the object of Notch type with Ellipse

object as its parent. beginning and ending points of Notch object do not coincide so, if

we use Auto option from Closed pop-up menu, we will get an open path, while we

want it to be closed when it is exported to Adobe Illustrator format.

After we will choose Yes option from Closed pop-up menu additional spline segment

will appear between endpoints and the path will become closed. You may see that num-

ber of Nodes (see description of this informational field below) increased from 18 to 19.

This happens because Excentro explicitly adds spline segment with new ending point

that coincides with beginning point of the path. We do it to avoid occasional problem

that may result from differences in handling of paths closed by simply specifying closed

attribute in some vector design applications.

If for some reason you want to avoid path closing by default Auto option, you may use

No option from Closed pop-up menu to explicitly clear closed attribute and path will

be exported as open.

■ There are two color fields in Path panel of Excentro Control window: Color Well

and color information field beside it.

Color Well is typically used to set color attribute of selected object by dragging color

patch to it either from Color Well of Color Mixer inspector or from colors list of

swatch palette window or from colors list of main document window.
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Dragging color patches to Color Well of Excentro Control to set object’s color.

You can also use drag-and-drop actions in another direction and drag color patch from

Color Well of Excentro Control. This way you can:

◆ Set same color to other objects by dragging color patch to rectangular represen-

tations of guilloche objects in structure pane or layers list of main document win-

dow. 

◆ Add new color to document colors list or change color attributes of existing

color in this list by dragging color patch to colors list of main document window. 

◆ Drag color patch to color patches of some layer rectangle in layers list to set this

color as selection color for this layer. 

◆ Set current object color as current color of Color Mixer inspector by dragging

patch from Color Well of Excentro Control to Color Well of Color Mixer

inspector.

There is a simpler way to set current color attribute of selected object as current color of

Color Mixer: just double-click Color Well of Excentro Control window with mouse

pointer.

Dragging color patches from Color Well of Excentro Control.

Informational field beside Color Well shows color system icon and component values

string for current object color. Component values are separated with comma. For exam-

ple, for CMYK colors this string looks like: C:100 M:70 Y:0 K:0, for RGB colors — R:255
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G:75 B:0, for Gray colors — K:100. For Spot colors the string shows color name and

tint value: T:100 PANTONE 315 CVC. By color space icon you can tell if current object

color is RGB, CMYK or Grayscale and if it is Spot or Process color. Spot colors have

round icons, process colors have square icons:

■ Size field of Path panel is the informational field that shows size of path’s bounding

box — the rectangle that completely encloses the path. First number corresponds to

width of the rectangle, second number corresponds to height of the rectangle. You can

use this information to improve precision of your guilloche work. Please, note that rec-

tangle size counts stroke weight attribute of the path and includes area of end caps and

spline joins. The value is shown in application-wide measurement units.

■ Nodes field at the bottom of the panel shows number of path nodes — joints of spline

segments of the path. It is the informational field only and can not be changed manually.

It can help experienced user to reduce or to increase number of path nodes using other

attributes of Excentro object to avoid occasional paths generation defects like loops or

sharp corners. You can manually edit nodes and spline segments later in any vector

based application after final design is exported in Adobe Illustrator format. Path nodes

are visible in document preview window if Show Nodes option is turned on in View

menu.
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MANAGING STEP & REPEAT SETS

As was mentioned in introduction to this chapter, Excentro has powerful ability to create

a set of additional object paths by modifying one or more attributes of the object. This

functionality is called ‘Step & Repeat Sets’. Any attributes in numeric fields of Excentro

Control window can be modified by Step & Repeat Sets. The number of Step & Repeat

Sets single guilloche object can have can also be more than one (in fact, it is unlimited).

This gives you very large area for experiments with different shapes and effects, though it

requires some knowledge and experience.

To create and delete Step & Repeat Sets you should use commands from Excentro

Control window menu (button with triangle in top right corner of the window).

■ Add Step & Repeat Set command creates new Step & Repeat Set. After this com-

mand is chosen Excentro Control window will expand to accommodate fields of new

Step & Repeat Set.

Example of simple Step & Repeat Set with Phase attribute modification of content element.

Objects with Step & Repeat Sets have small ‘plie’ icons in right top corner of their rec-

tangle representations in structure pane of main document window. This helps you to

identify objects with Step & Repeat Sets quickly.

Object’s rectangle before and after Step & Repeat Set was added.
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■ You can choose to expand Step & Repeat Set with Expand Step & Repeat Set com-

mand.

After this command is chosen, new copies of guilloche object will be created. The num-

ber of copies is defined by value in Number of Steps field of Step & Repeat Set. Each

copy will have different values of attributes that were modified by increments of original

Step & Repeat Set. New attribute values will be calculated in a way that paths of all new

objects will be same as additional paths of Step & Repeat Set. That is: the attribute value

of new object is set to the attribute value of original object plus modifications required

by next step of Step & Repeat Set. Step & Repeat Set of original object will be deleted

after its expansion.

There is no much reason to expand Step & Repeat Sets and create many copies of the

object. Step & repeat functionality of Excentro was originally designed specifically to

avoid creation of copies of same object just to make additional paths with slightly modi-

fied attributes. Anyway, Step & Repeat Sets expansion command is here if you will need

to use it.

■ You can delete Step & Repeat Set without expansion. Just use Delete Step & Repeat

Set command to do so. Excentro Control window will shrink back again to its original

size after Step & Repeat Set is deleted.

■ If you will add more than one Step & Repeat Set to selected object Excentro Control

window will expand again to show list of Step & Repeat Sets. You can use this list to do

one of three following tasks:
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◆ Select different Step & Repeat Set, so its attributes and parameters will be shown

in fields of expanded Excentro Control window. Just click name of the set in the

list with mouse pointer, to select it.

◆ Rename sets so they will become easier to identify. Double-click name of Step &

Repeat Set to make it editable and type new name.

◆ Change sets order in the list. Click Step & Repeat Set item to select it, then, hold-

ing mouse button pressed, drag the item to new position in the list, release mouse

button.

To illustrate situation when creation of more than one Step & Repeat Set can benefit

guilloche design creation let us provide an example of simple regular background design

created with only two structure tree objects and three Step & Repeat Sets.
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1. We are creating regular linear background, so let us start with Line base object

and single child element of Cycloid type:

2. First Step & Repeat Set that we will add to element of Cycloid type will reflect

its path relative to line of its parent object by modifying Amplitude and Base

Offset attributes. We will get pattern of two intersecting cycloids.

3. Second Step & Repeat Set will modify Phase, Side Size and Base Offset attrib-

utes of two cycloid paths, so that we will make another pair of intersecting paths

with slightly different cycloid shape positioned above the first pair.
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4. Final third Step & Repeat Set will modify only Base Offset attribute of Cycloid

object to repeat four existing paths six times more and to complete creation of

this simple background.

Example above shows how you can use step & repeat functionality of Excentro to make

the background of 24 paths. There are other ways to make identically looking back-

ground in Excentro including the one with creation of 24 Cycloid objects each with

individual attributes and none Step & Repeat Sets. However, using multiple Step &

Repeat Sets that all belong to single object allows you later to modify all paths of the

background as whole by editing attribute values of just one Cycloid object instead of

selecting several objects one after one and reapplying same attribute modification to all

of them.

STEP & REPEAT SET FIELDS

■ Expanded version of Excentro Control window for objects with Step & Repeat Sets

has one additional numeric field in top part of the window, where icons and titles of the

panels as well as window menu triangle button are located. This field has same ‘pile’ icon

beside it that is used to identify objects with Step & Repeat Sets:
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This is Number of Steps field. For objects with only one Step & Repeat Set, value in this

field is the same as total number of object paths: main path of the object plus additional

paths of Step & Repeat Set. (For objects with more than one Step & Repeat Set total

number of object paths is calculated by multiplying Number of Steps values of all its

sets). This value can be treated as ‘the number of objects that paths of this object with

Step & Repeat Set can replace’. It defines the number of times that set modifications are

applied to the object attributes to create additional paths:

◆ If the value of Number of Steps field is ‘1’, then Step & Repeat Set does not

produce any additional paths for this object. Guilloche paths of the object with

Step & Repeat Sets whose Number of Steps values equal to ‘1’ are identical to the

paths of the object without any Step & Repeat Sets.

◆ If the value of Number of Steps field is greater than ‘1’, then additional paths

are created and number of them is equal to this value minus 1. The first additional

path is produced by applying set modifications to object attributes once, the last

additional path is produced by applying set modifications to object attributes

‘Number of Steps – 1’ times. 

Example: If Number of Steps value is equal to ‘2’, then only one additional path

will be created; if Number of Steps value is equal to ‘10’, then nine additional

paths will be created, if increment values of the set are like on picture above, then

first path will be produced with Phase attribute value equal to ‘36°’, last — ‘324°’
(thus main and additional paths of the object will cover whole 360° interval of

Phase attribute).

■ Attribute modifications of Step & Repeat Set are specified by Increment fields locat-

ed beside fields of object attributes they modify.
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Type of Increment field is controlled by pop-up menu beside it. This menu contains

five different options: Constant, Line, Root, Sine and Sine+:

To illustrate these types of Increment we will construct an example of very simple

background that has two elements: base object of Line type and child element of

Cycloid type.

Cycloid object has Step & Repeat Set with Number of Steps value set to ‘30’ that

amounts to 30 object paths — one main path and 29 additional ones produced by this

Step & Repeat Set (see Number of Steps field description above). Step & Repeat Set ini-

tially has only Move Y attribute Increment of Constant type with non-zero value of

‘5pt’. This Increment offsets each next path by 5 points up relative to previous one. We

will not modify this value in foregoing discussion — it is just there to make illustrations

more instructive, instead we will assign different values to Move X attribute Increment

and look at the changes on our background.
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■ Constant type of Increment is the simplest and the most common one. This

Increment is defined only by one numeric value. At each step of Step & Repeat Set this

value gets added to attribute value accumulated on previous steps. 

Example: If we will assign Constant type Increment with ‘3pt’ value to Move X

attribute, 30 paths of our background example will have horizontal offsets with

following values: 0pt, 3pt, 6pt, 9pt, 12pt,… 87pt.

Some attributes with values in degrees (‘°’) and percents (‘%’) have Auto checkbox

beside their Increment fields of Constant type. If this checkbox is ‘on’ the value of

Increment is calculated automatically by dividing whole range of 360° or 100% by

number of paths that is required to uniformly cover this interval and can not be modi-

fied. This simplifies setting of Step & Repeat Sets for objects whose paths should be

evenly distributed through whole available range of attribute values (e.g. space between

paths of parent objects for content elements on picture below).

Paths of content elements produced with Auto option.
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■ Line type of Increment is defined by two numeric values. These values are used to

calculate the final increment value that gets added to attribute value accumulated on

previous steps of Step & Repeat Set. The final increment value is calculated using formu-

la:

increment = value1 + value2 • number_of_step

Where number_of_step is the number of each step in the Step & Repeat Set, with value 0

(zero) corresponding to main path of the object.

Example: If we will assign Line type Increment with ‘3pt' and ‘0.2pt’ values to

Move X attribute, 30 paths of our background example will have horizontal off-

sets with following values: 0pt, 3.2pt, 6.6pt, 10.2pt, 14pt,… 165.2pt, 174pt.

If second value of Line type Increment is zero, then it is identical in behavior to

Constant type Increment with value set to the first value of Line type Increment.

Next example illustrate the case, you can compare it with picture on previous page: 30

paths of our background example have horizontal offsets: 0pt, 3pt, 6pt, 9pt, 12pt,… 87pt

■ Root type of Increment is defined by three numeric values. These values are used to

calculate the final increment value that gets added to attribute value of the object. The

final increment value is calculated using formula:

increment = value1 • √(value2 • number_of_step + value3)

Where number_of_step is the number of each step in the Step & Repeat Set, with value 0

(zero) corresponding to main path of the object.

The main difference from two previously described Increment types is that attribute

value of the object is not accumulated on previous steps of Step & Repeat Set. No mat-
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ter what pervious increment values were, attribute value of the object on every step of

the Set is calculated as sum of initial value from attribute field of Excentro Control

window and increment value calculated using formula above.

Example: If we will assign Root type Increment with ‘10pt’, ‘5’ and ‘0’ values to

Move X attribute, 30 paths of our background example will have horizontal off-

sets with following values: 0pt, 22.36pt, 31.62pt, 38.73pt, 44.72pt,… 120.42pt.

■ Sine type of Increment is also defined by three numeric values. These values are used

to calculate the final increment value that gets added to attribute value of the object. The

final increment value is calculated using formula:

increment = value1 • sin(value2 • number_of_step + value3)

Where number_of_step is the number of each step in the Step & Repeat Set, with value 0

(zero) corresponding to main path of the object.

Argument of sin() function (the value in brackets in formula above) is expressed in

degrees (‘°’). To cover whole 360° range of sin() arguments by paths of Step & Repeat Set,

value2 should be calculated as ratio of 360° and Number of Steps value for this Set.

Just like with Root type Increment attribute value of the object is not accumulated on

previous steps of Step & Repeat Set. No matter what pervious increment values were,

attribute value of the object on every step of the Set is calculated as sum of initial value

from attribute field of Excentro Control window and increment value calculated using

formula above.

Example: If we will assign Sine type Increment with ‘20pt’, ‘12’ and ‘0°’ values

to Move X attribute, 30 paths of our background example will have horizontal

offsets with following values: 0pt, 4.16pt, 8.13pt, 11.76pt, 14.86pt,… –4.16pt.
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■ Sine+ type of Increment is similar to Sine type Increment. It is defined also by

three numeric values. These values are used to calculate the final increment value using

same formula:

increment = value1 • sin(value2 • number_of_step + value3)

Where number_of_step is the number of each step in the Step & Repeat Set, with value 0

(zero) corresponding to main path of the object.

But unlike Sine type Increment attribute value of the object is accumulated on previ-

ous steps of Step & Repeat Set. That is: attribute value for any given step is a sum of initial

value from attribute field of Excentro Control window and increment values (calcu-

lated using formula above) of all previous steps of Step & Repeat Set.

Argument of sin() function (the value in brackets in formula above) is expressed in

degrees (‘°’). To cover whole 360° range of sin() arguments by paths of Step & Repeat Set,

value2 should be calculated as ratio of 360° and Number of Steps value for this Set.

Since attribute value is accumulated using both negative and positive increment values if

we want to get truly periodic look of Step & Repeat Set we should start with maximum

sin() value, that could be reached by setting value3 to 90° (sin(90°)=1).

Example: If we will assign Sine+ type Increment with ‘10pt’, ‘12’ and ‘90°’ val-

ues to Move X attribute, 30 paths of our background example will have horizontal

offsets with following values: 0pt, 9.78pt, 18.92pt, 27pt, 33.7pt,… -10pt.

ADDITIONAL NOTES ON STEP & REPEAT SETS

Information in this section does not directly relate to Excentro Control inspector, we

decided to put it here to make Step & Repeat Sets coverage in this chapter more com-

plete in case you will look for details here.

■ Selection colors. Excentro uses two special colors to show paths of selected object in

document preview window. First color is used for main path of the object, second color

shows additional paths that belong to Step & Repeat Sets.

These colors are defined and can be changed in layers list of main document window. To

change selection color you can drag color patch, for example, from Color Well of

Color Mixer inspector to one of two small color patches in rectangle that represents

the layer in layers list. Left color patch in layer rectangle corresponds to selection color

of main path. Right color patch corresponds to selection color for additional paths of

Step & Repeat Sets.
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Each layer may have its own set of two colors used to show selected paths. You can find

setting different colors to different layers helpful if you would like to check visually if

document selection belongs to this or that layer. You can set same color value to both

colors used for paths selection. In this case main path and paths of Step & Repeat Sets

will be displayed with same color in preview window.

Selection color used for main object path will be exported as selection color for that

layer, when you export job in Adobe Illustrator format at the end of your work.

■ Step & Repeat Sets and child elements. Since paths of child elements ‘are based

on path of their parent object’, Step & Repeat Set added to parent object will not only

produce additional paths for this object but it will create additional paths for all its child

elements as well. To illustrate this behavior let us consider following example.

1. Let us create base object of Ellipse type with single child object of Sine Wave

type — usual case at the beginning of guilloche design process.

2. Now we will add Step & Repeat Set to Ellipse base with Number of Steps

value ‘3’ and Width attribute Increment of Constant type ‘–25pt’.
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3. After Step & Repeat Set is added to the base you can see that two additional

ellipse paths are produced for this object. These paths have Width attribute of

‘75pt’ and ‘25pt’ respectively. But, please, note two additional paths produced for

Sine Wave child object as well. These paths have same attributes of Sine Wave

object like Frequency, Phase and Amplitude and they behave as if each of them

was based on new additional paths of the base object produced by Step & Repeat

Set modification.

Only direct child objects (and direct child objects of these child objects) will have addi-

tional paths after Step & Repeat Set is added to their parent. Step & Repeat Set will not

create additional paths for objects which use the object with this Set as ‘second base’ or

‘direction’ element or modify these objects paths in any other way.

SHOW PROPERTY INSPECTOR

On the closing page of this chapter let us mention the last command of Excentro

Control window menu — Show Property Inspector command.

Show Property Inspector command brings to screen another inspector window of

Excentro application called Property Inspector. This inspector is a companion to

Excentro Control inspector. It helps you to change value of active attribute field in

Excentro Control window dynamically using slider control and increment/decrement

buttons.

Next Chapter 6: Property Inspector provides more information on Property

Inspector window controls and usage.
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CHAPTER 6: PROPERTY INSPECTOR

Property Inspector is one of Excentro inspectors (as it name suggests). Like other

inspector windows and Toolbar it floats above document windows layer and can be

brought to screen with command from Inspectors submenu of Window menu.

Check mark appears beside Property Inspector command in Inspectors submenu

when Property Inspector window is on the screen. Choosing this command second

time will hide the inspector.

Property Inspector is a companion to Excentro Control inspector. It helps to

change attribute values gradually by small increments after specifying them roughly in

Excentro Control. Due to this close relationship Property Inspector can also be

summoned to screen with Show Property Inspector command from window menu

of Excentro Control (button with triangle in top right corner of the window):

Property Inspector allows you to experiment with attribute values and see how these

values transform shape of your guilloche design. In Excentro Control window you can

set attribute values of selected object using numeric fields or pop-up menus with presets.

Property Inspector adds slider and increment/decrement buttons. With these con-

trols you can change attribute value dynamically with graphics path preview of selected

object changed in real time or explore small variations of current attribute value. 

We could add slider and increment/decrement buttons beside every field of Excentro

Control, but decided against this idea. Considering number of fields and attributes of

Excentro Control that would make this window too big too be usable. Instead we

placed these controls in single Property Inspector window. This approach helps us to

minimize screen usage and allows to create more flexible controls versions.
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PROPERTY INSPECTOR WINDOW

With Property Inspector you can edit only one attribute of selected object in Excentro
document at time. This attribute is the currently active field of Excentro Control win-

dow (the one with blinking text caret that accepts keyboard input). To edit another

attribute with Property Inspector just click with mouse pointer different field of

Excentro Control to activate it.

Title of Property Inspector window reflects the name of the active attribute it edits:

No attributes of Excentro Control are active. Property Inspector window title is set to
default ‘Property Inspector’

Width is active attribute of Excentro Control. Property Inspector window title is set to
‘Property Inspector: Width’

Angle is active attribute of Excentro Control. Property Inspector window title is set to
‘Property Inspector: Angle’
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PROPERTY INSPECTOR CONTROLS

The text field at the bottom of Property Inspector window is Current Value field. It

shows current value of the attribute Property Inspector is used to change. It is the

same value as that of active field in Excentro Control. You can not directly enter new

value in Current Value field. If you want to set this value by typing, you should use text

field in Excentro Control window instead.

‘+’ and ‘–’ buttons beside Current Value field are Increment and Decrement but-

tons. They are used to change current attribute value by small amounts. Increment but-

ton adds small value to current attribute value, Decrement button subtracts small value

from current value. The value of increment and decrement depends on type of the

attribute and current interval of Slider control in top part of Property Inspector win-

dow.

The interval of Slider control is defined by Minimum Value and Maximum Value

fields located beside it. You can make this interval larger or smaller with ‘<’ and ‘>’ but-

tons below these fields. These buttons can increase or decrease the interval by half of

current interval size.

While you drag Slider control you will see as value in Current Value field and corre-

sponding active field of Excentro Control changes together with current Slider posi-

tion. Graphics path preview of selected object in document preview window is changed

too according to new attribute value.

Excentro uses two special colors to show paths of selected object in document preview

window. First color is used for main path of the object, second color shows additional

paths that belong to Step & Repeat Sets (if selected object has any Step & Repeat Sets).
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While you drag the slider, only main path of the object changes in real time. Paths of

Step & Repeat Sets will be updated later as soon as you release mouse button after drag.

This helps to make attribute changes more clearly visible when your guilloche design

becomes very complex with many intersecting paths. Main path of the object, that cor-

responds to initial attribute value, is shown with second color during the drag (same

color that is used to show Step & Repeat Sets).

PROPERTY INSPECTOR USAGE

In this section we will show how behavior of controls in Property Inspector window

changes according to type of attribute its is used to edit. Let us consider most common

example: the element of Sine Wave type in document structure tree:

■ Integer values. Frequency attribute of Sine Wave element is of integer type with

acceptable values from 0 to infinity. You can type rational values like: ‘3.5’ or ‘4.1’ too,

but in most cases the does not make any sense. When you activate this field in Excentro

Control window, Property Inspector controls are set as shown on picture below:

Minimum Value is set to ‘0’ and its ‘<’ button becomes inactive because negative fre-

quencies just does not make a lot of sense. Maximum Value field is set to ‘100’ because

you probably will not need higher values for your guilloche design.

If initial value in Excentro Control was higher than ‘100’ from the start, then

Minimum Value and Maximum Value fields will be set to ‘initial value – 100’ and

‘initial value + 100’ instead of ‘0’ and ‘100’.

When you click Increment and Decrement buttons beside Current Value field cur-

rent value will be changed by ±1.

■ Angle values. Phase attribute of Sine Wave element is of angle type. It is measured

in degrees ‘°’ and can have values from ‘–180°’ to ‘+180°’ (whole 360° period). You can

type larger or smaller values like: ‘270°’ or ‘450°’ too, but they will be reduced to ‘-90°’

and ‘90°’ accordingly. When you activate this field in Excentro Control window,

Property Inspector controls are set as shown on picture on next page: Minimum
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Value is set to ‘-180°’, Maximum Value is set to ‘+180°’ and ‘<’, ‘>’ buttons are deactivat-

ed because interval of Slider control can cover whole 360° range of acceptable values. 

Increment and Decrement buttons beside Current Value field will change current

value by ±2.5° (it is a length of Slider control divided by 360).

For some attributes of angle type, for example: Arc Start and Arc Length of Circle

base element, acceptable range is not ‘–180°’ to ‘+180°’, but ‘0°’ to ‘360°’ because it seems

to be more logical.

For Skew angles in Transform panel of Excentro Control range is shorter: ‘–90°’ to

‘+90°’, and increment for Increment and Decrement buttons is smaller: ±1°.

■ Rational values. Amplitude attribute of Sine Wave element is of rational type with

values measured in application-wide measurement units selected in General panel of

Excentro Preferences dialog. It could be points (‘pt’), millimeters (‘mm’), centimeters

(‘cm’) or inches (‘in’). These values do not have limitations of acceptable range.
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When you activate this field in Excentro Control window, Minimum Value of Slider

control interval will be set to ‘–100 units’, Maximum Value will be set to ‘+100 units’. If

current value is higher than ‘+100 units’ or smaller than ‘–100 units’, Slider control

interval will be centered to allow 100 units to its Minimum Value and 100 units to its

Maximum Value. You can always change these values with ‘<’, ‘>’ buttons below them.

When you click Increment and Decrement buttons beside Current Value field cur-

rent value will be changed by ±1 unit.

Same is right about attributes of percentage type with values measured in positive and

negative percents ‘%’ like Scale values in Transform panel of Excentro Control.
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CHAPTER 7: COLOR MIXER

Like many other graphics design applications Excentro has a special utility window that

allows user to change object’s color attributes using numeric fields or sliders. In Excentro
this window is called Color Mixer. It also can be used to convert color values between

different color spaces.

Color Mixer window floats above Excentro document windows, just like Toolbar and

other Inspector windows. If it is not on the screen you can summon it with Color

Mixer command from Inspectors submenu of Window menu or by double-clicking

color value you want to edit.

The look of Color Mixer window changes according to the color space of current

color. To convert color values into different color space (CMYK, RGB or Grayscale) you

can click appropriate color space title in top part of Color Mixer window. Color con-

version will be performed according to ColorSync profile settings configured in Color

panel of Excentro Preferences dialog.

You may want to ‘collapse’ Color Mixer window by clicking title of selected color space

again. This way you can minimize Color Mixer screen usage when you do not need it

without closing the window completely. Color Mixer window will shrink to hide panel

content with values and sliders. This feature was designed for Mac OS X users who miss

‘window shade’ feature similar to that of Mac OS 9. To expand the window to normal

size, click title of color space you want to see.
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FIELDS AND CONTROLS

Color Mixer window has two distinct parts. Top part contains color space icons and

titles that are used to switch between different color space panels. Central window part

shows color panel content with set of fields and controls. Number of fields and controls

differs depending on panel type (CMYK, RGB, Grayscale or Spot Color) but they all serve

same purpose: give user ability to change color value with numeric fields or slider con-

trols.

Other controls in Color Mixer window has following functions:

■ Color well control gives visual illustration of current color values and serves

as source and target location for drag-and-drop actions. To set current Color

Mixer color with drag-and-drop you can drag color patch from swatch palette

window or colors list of Excentro document window and drop it to color well.

To apply Color Mixer color to object you can drag color from color well and

drop it over object representation in layers list or structure pane of document

window.

■ System Color Picker button could be used to set current Color Mixer color

with standard Mac OS system Color Picker. When you click this button, standard

Color Picker dialog will open up, where you can select color you like using any of

available color pickers:

When you finished with color selection in system Color Picker click OK button

and new color will appear in Color Mixer converted to previously selected color

space. Conversion is performed according to ColorSync profile settings configured

in Color panel of Excentro Preferences dialog.
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There are four different color space panels: CMYK, RGB, Grayscale and Spot Color.

These panels have following fields and controls:

■ CMYK panel has four color value numeric fields and sliders accompanying

them: C (Cyan), M (Magenta), Y (Yellow) and K (Black). These values are directly

related to C, M, Y, K subtractive color space attributes and specify values as per-

centage 0% – 100%. Value CMYK = (0%,0%,0%, 0%) corresponds to white (no

color), value CMYK = (100%,100%,100%,100%) is the darkest ‘maximum all col-

ors’ position.

■ RGB panel has three numeric fields and accompanying sliders: R (Red),

G (Green) and B (Blue). These values correspond to R, G, B additive color space

attributes and specify values in 0 – 255 range. Value RGB = (0,0,0) is the darkest

‘black’ color, RGB = (255,255,255) is lightest ‘white’ color. (Relations to real visual

black and white colors is controlled by RGB color space and monitor profiles

defined in Excentro Preferences dialog.)

■ Grayscale panel has just one numeric field and slider: K (Black). This value

shows gray tint of Black color and specifies value as percentage 0% – 100%. 0%

corresponds to white (no color) and 100% to black.

Please, note that Color panel of Excentro Preferences dialog has special Use

profiles to convert from Gray to CMYK checkbox. When this checkbox is off,

switching from Grayscale to CMYK color space will set K component of CMYK

color to same value as K percentage of Gray tint, the rest of CMY components will

be set to 0%. When the checkbox is on, conversion will be performed through

ColorSync technology and will depend on profiles selected for CMYK and

Grayscale color spaces. In most cases all four of CMYK components will get some

non-zero values.
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■ Spot Color panel has single numeric field and slider: T (Tint). This value shows

tint of current spot color as percentage 0% – 100%. 0% corresponds to no color

and 100% to maximum color shade. Information fields below the slider show spot

color name and process approximation either in CMYK or RGB values, depending

on type of the spot color.

You can use Color Mixer to convert spot color tint to process (CMYK, RGB or

Gray) color space To convert process color in CMYK, RGB or Gray color space to

spot color you should use colors list of main document window.

Creating spot colors: (Though description of this procedure should belong to Colors
List part of Chapter3: Main Document Window chapter of this reference book, let us
repeat it here in case you will search later for spot color creation subject on same pages
where spot color editing with Color Mixer was described.) Creation of spot colors in

Excentro could be performed in four easy steps:

Step 1. First, you should mix visual color representation in Color Mixer.

Step 2. Next, you drag the color patch from color well of Color Mixer to colors

list of Excentro main document window to add new swatch to the list.

Step 3. After that you can edit new swatch name to whatever you like, if needed.

Step 4. Final step is to use Make Spot command from document colors list menu

to convert process color of selected swatch to spot color.

Excentro Windows Reference

Chapter 7: Color Mixer

7-4

Swatch color before 
Make Spot command

Swatch color after 
Make Spot command



APPLYING COLOR TO OBJECTS

Color Mixer behavior in Excentro is similar to inspector window of same name in

Macromedia FreeHand application. Unlike Color palette of Adobe Illustrator, Color

Mixer is not directly connected to selected objects in document window. This way you

do not have to disselect current object just to experiment with sliders and new color val-

ues.

To avoid occasional mistakes with color assignment most of actions that change objects

color in Excentro should be performed with explicit drag-and-drop actions.

To apply current Color Mixer color to object you can do one of following:

■ drag color patch from color well of Color Mixer to rectangle that represents

the object in structure pane or layers list of main document window. This way

you can change color of objects without selecting them in document windows

first. It could be more comfortable method if you want to set same color to more

than one object in document without changing current selection.

■ select the object you want to change color of in main document window or

preview document window, then open Path panel of Excentro Control win-

dow and drag color patch from color well of Color Mixer to color well of

Excentro Control window. This method allows you to change color of the object

after selecting its paths in document preview window without a need to search for

the object representation in structure pane or layers list of main document window.

As with any other user actions that change Excentro objects and their properties, color

changes can be undone and reapplied back with Undo and Redo commands from Edit

menu at any later time.

Assignment of color to document objects with drag-and-drop actions is used not only

for colors from Color Mixer, but for colors from swatch palettes and document colors

lists as well. Just drop color patch you want on object in document window or color well

in Excentro Control inspector.
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CHANGING PATHS SELECTION COLORS FOR LAYERS

Document preview windows of Excentro use two different special colors to display

paths that belong to selected object of document. First color is used for main object

path, second color shows additional paths that belong to Step & Repeat Sets of selected

object, if selected object has any Step & Repeat Sets.

To change colors used for selected paths display, you can use drag-and-drop action simi-

lar to object color assignment discussed in section above. First, mix color you like in

Color Mixer window, then drag color patch from color well to small color patches in

rectangle that represents the layer in layers list of main document window. Left color

patch in layer rectangle corresponds to selection color of main path. Right color patch

corresponds to selection color for additional paths of Step & Repeat Sets.

Each layer may have its own set of two colors used to show selected paths. You can find

this option helpful if you would like to check visually if document selection belongs to

this or that layer.

You can set same color value to both colors used for paths selection. In this case main

path and paths of Step & Repeat Sets will be displayed with same color in preview win-

dow.

Selection color used for main object path will be exported as selection color for that

layer, when you export job in Adobe Illustrator format.
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ADDING AND CHANGING ENTRIES IN DOCUMENT COLORS LIST

Another usage for drag-and-drop actions with color from Color Mixer is to add new

swatches to document colors list or to change color value of existing swatches in the list.

1. (Arrows number 1 on pictures below) To add new swatch to colors list of main docu-

ment window drag color patch from color well of Color Mixer to any place in the

colors list in List View mode except for small color patch rectangles that show color

representation of color swatches. If document colors list switched to Swatch View

mode drop color patch to empty white area below the last swatch rectangle.

New color swatch will be added to the list with color value equal to current Color

Mixer color dropped to the list. Name of new swatch will be created from its numeric

color attributes, e.g. C:0 M:79: Y:91 K:0 if color is in CMYK color space (see picture

below), or R:196 G:35 B:39 if color is in RGB color space, or K:63 if color is in Grayscale

color space, or 42% PANTONE 101 CVC if color is a tint percentage of spot color. You can

edit swatch name later to make it more meaningful for your work: double-click name of

swatch in the list and type new one.

2. (Arrows number 2 on pictures below) To change color value of existing swatch in col-

ors list of document window drag color patch from color well of Color Mixer to small

color patch rectangle that shows color representation of the swatch you want to change.

All objects in Excentro document that were assigned this swatch color will have their

color value updated to new one as well. If name of the swatch was created automatically

as described above it will be changed to new name created from updated color values (if

new name will be a unique name in the colors list).
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SETTING CURRENT COLOR MIXER COLOR

When you want to modify color of the object in Excentro document or convert current

object color to different color space you will have to set Color Mixer color to existing

color value first. To do so you can use either double click or drag-and-drop action:

■ double click color setting works with any color patch from Excentro document

window, color well of Excentro Control inspector or color patches from swatch

palettes. Circles and ellipses on picture below show areas you can double click to

set Color Mixer color to their value. If Color Mixer window was closed before

you double click a color patch, it will reappear on screen in same location it was

shown last it time it was used. If Color Mixer window was collapsed it will be

restored to its normal size. Proper color space panel will be selected to show new

color values.

■ drag-and-drop color setting could be used with following objects and controls

of Excentro user interface: color well of Excentro Control inspector, items of

document colors list or swatch palettes (see dotted arrows on picture above). Just

drag color patch from these areas and drop it to color well of Color Mixer win-

dow. Proper color space panel will be selected to show new color values. You can

use double click color setting on same areas as was described above with same

results. Drag-and-drop method of color setting is preserved to make usage of drag-

and-drop actions for color operations more consistent.
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CHAPTER 8: SWATCH PALETTES

Like many graphic arts applications and software tools Excentro has special utility win-

dows to manage predefined sets of colors. These windows and color sets they show are

called ‘swatch palettes’. You can use swatch palettes to colorize objects in Excentro docu-

ments or add colors to colors lists of Excentro documents using colors from industry

standard libraries like PANTONE® or from your own custom lists created with color

measurement devices like spectrophotometers.

Excentro allows you to use three types of files as swatch palettes:

■ Excentro document files. In this case the colors list of the document is shown in

Swatch Palette window in more compact and convenient way, than in main

document window. Swatch Palette windows also have read-only attribute, so

you can avoid occasional unwanted changes of color values.

■ Color libraries in EPS format, like once created with spectrophotometers and

special software like X-Rite ColorShop. You can also use just any EPS format files

with spot colors exported from graphics editing software applications.

■ Adobe Illustrator files and color libraries saved in Adobe Illustrator EPS format

(not in Adobe Illustrator PDF format, if you are using Adobe Illustrator version 9

and higher be sure to resave files in format compatible with version 8 and earlier).

In this case Swatch Palette window will show swatch list of Adobe Illustrator
document, similar to its appearance in Swatches palette of Adobe Illustrator.
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MANAGING SWATCH PALETTES

There is a special location where you can store frequently used swatch palette files:

‘Swatch Palettes ƒ’ folder that could be found in same folder as Excentro application.

Files found in this folder are automatically inspected at application start up and if they

belong to one of three file types mentioned above, they are added to the list in Swatch

Palettes submenu of Window menu.

Three standard color libraries of Adobe Illustrator 8 added to ‘Swatch Palettes ƒ’ folder.
They and ‘Default’ Excentro palette of will be listed in Swatch Palettes submenu.

When you install Excentro application for the first time ‘Swatch Palettes ƒ’ folder con-

tains just one file named ‘Default’. This is Excentro document with default colors list

that gets automatically added to any new created document. Later, you can edit colors in

this document or specify another file to be used in its place (by checking Use as

Default option in window menu of desired Swatch Palette window).

You can open any of swatch palette files in ‘Swatch Palettes ƒ’ folder by choosing its

name from Swatch Palettes submenu of Window menu. Check mark symbol will

appear in the submenu beside opened file name. Choosing this file again from the sub-

menu will not close the open palette window, like it happens with inspector windows, but

will bring this window in front of you. After you add new files to ‘Swatch Palettes ƒ’ fold-

er, please, restart Excentro application to see them listed in Swatch Palettes submenu.

Other… command of Swatch Palettes submenu allows you to open swatch palette

files found in other folders on your hard disks or network. When you choose this com-

mand standard file navigation dialog will appear where you can select proper file:
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VIEW MODES

Swatch Palettes windows float above Excentro document windows just like inspectors

and Toolbar. These windows can show swatch palette colors in one of two modes: List

View and Swatch View. You can switch between these modes by clicking buttons in

top part of Swatch Palette window or by using palette window menu (button with tri-

angle in top right corner of the window).

■ List View is the default view for swatch palette. This view mode shows color

patch, swatch name, color system and if this color is a spot or process color. This

mode could be used to identify swatches by name.

Icons on right side of list entry show color space of the swatches: RGB, CMYK or

Grayscale and if it is Spot or Process swatch. Spot swatches have round icons,

process swatches have square icons beside their names:

■ Swatch View. This view mode shows only color patch of the swatches. This

mode gives you more compact view of the palette.
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SWATCH PALETTE WINDOW MENU

Swatch Palette windows in Excentro have additional options accessible through their

window menu (button with triangle in top right corner of the window):

Swatch View. When you select this option swatch palette view mode will be switched

to Swatch View (see section above). Check mark appears beside this item when

Swatch View view mode is chosen.

List View. When you select this option swatch palette view mode will be switched to

List View (see section above). Check mark appears beside this item when List View

view mode is chosen.

Find Closest Swatch command lets you select swatch in this palette with closest color

values to current Color Mixer color. You can use this command to find closest PAN-

TONE® or other color library approximation to color you mixed using CMYK or RGB

sliders. Use two following steps:

1. Compose color you want in Color Mixer inspector window using sliders and

other controls.

2. Choose Find Closest Swatch command from window menu of Swatch

Palette window. Colors list in palette window will be compared and swatch with

closest color values to current Color Mixer color will be selected.

This command is available only when color management is switched on with Use

ColorSync™ checkbox in Color panel of Excentro Preferences dialog. Colors are

compared using ∆E values of their coordinates in Lab color space. Results might differ

depending on current ColorSync profiles selection.
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Open on Start Up. Swatch palette windows with this option switched on will be

opened automatically next time you start Excentro.

Use as Default. There could be only one palette with this option checked. This palette

will be used as initial colors list for new Excentro documents. When you install Excentro
for the first time swatch palette named ‘Default’ in ‘Swatch Palettes ƒ’ folder, located

in same folder as Excentro application, will be used as initial colors list. Later you can

either open this document file in Excentro, like standard Excentro document with Open

command from File menu, and modify its colors list of main document window or

you can appoint another swatch palette to serve as initial colors list for all new docu-

ments by checking its Use as Default option.

SETTING CURRENT COLOR MIXER COLOR WITH SWATCH PALETTE

One of primary tasks you will want to accomplish with colors from swatch palettes is to

set current Color Mixer color. You may want to do so to inspect colors before applying

them to objects in Excentro documents or to mix a shade of swatch palette’s spot color

value, for example. To set current Color Mixer color you can either double click swatch

patch in swatch palette list view or swatch view area or drag-and-drop color patch to

color well of Color Mixer window as shown by arrows on picture below.

If Color Mixer window was closed before you double clicked a color patch, it will reap-

pear on screen in the same location it was shown last it time it was used. If Color Mixer

window was collapsed to its title bar or color space titles and icons bar it will be restored

to normal size. Proper color space panel: CMYK, RGB, Grayscale or Spot Color will be

selected to show new color values from swatch palette.
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APPLYING SWATCH COLOR TO OBJECTS

You can set color of object in Excentro document directly from Swatch Palette win-

dow without setting this color as current color of Color Mixer first. Most of actions that

change objects color in Excentro should be performed with explicit drag-and-drop

actions. To apply color from Swatch Palette window to object in Excentro document

you can do one of the following:

■ Drag color patch from Swatch Palette window list view or swatch view area to

rectangle that represents the object in structure pane or layers list of main docu-

ment window (this drag action is shown with green arrows on picture below).

This way you can change color of objects without selecting them in document

windows first. It could be more comfortable method if you want to set same color

to more than one object in document without changing current selection.

■ Select the object you want to change color of in main document window or

document preview window, then open Path panel of Excentro Control win-

dow and drag color patch from Swatch Palette window list view or swatch view

area to color well of Excentro Control window (this drag option is shown with

purple arrows on picture below). This method allows you to change color of the

object after selecting its paths in document preview window without a need to

search for the object rectangle representation in structure pane or layers list of

main document window.

As with any other user actions that change Excentro objects and their properties, color

changes can be undone and reapplied back with Undo and Redo commands from Edit

menu at any later time.

Assignment of color to document objects with drag-and-drop actions is used not only

for colors from Swatch palette windows, but also for colors from Color Mixer and

document colors lists. Just drop color patch you want on object in document window or

color well in Excentro Control inspector to set its value to the object.
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CHANGING PATHS SELECTION COLORS FOR LAYERS

Document preview windows in Excentro use two different colors to display paths

that belong to selected object of the document. First color is used for main object path,

second color shows additional paths that belong to Step & Repeat Sets of selected object

(if selected object has any Step & Repeat Sets).

To change colors used for selected paths display, you can use drag-and-drop action simi-

lar to object color assignment discussed in section above. Drag color patch from Swatch

Palette window list view or swatch view area to small color patches in rectangle that

represents the layer in layers list of document window. Right color patch in layer rectan-

gle corresponds to selection color of main path. Left color patch corresponds to selec-

tion color for additional paths of Step & Repeat Sets.

Each layer may have its own set of two colors used to show selected paths. You can find

setting different colors to different layers helpful if you would like to check visually if

document selection belongs to this or that layer.

You can set same color value to both colors used for paths selection. In this case main

path and paths of Step & Repeat Sets will be displayed with same color in preview win-

dow.

Selection color used for main object path will be exported as selection color for that

layer, when you export job in Adobe Illustrator format at the end of your work process.
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ADDING AND CHANGING ENTRIES IN DOCUMENT COLORS LIST

Another usage for drag-and-drop actions with color patches from Swatch Palette win-

dow list view or swatch view area is to add new swatches to document colors list or to

change color value of existing swatches in the list.

1. (Arrows number 1 on pictures below) To add new swatch to colors list of main docu-

ment window drag color patch from Swatch Palette window list view or swatch

view area to any place in the document colors list in List View mode except for small

color patch rectangles that show color representation of color swatches. If document

colors list switched to Swatch View mode drop color patch to empty white area below

the last swatch rectangle.

New color swatch will be added to the list with same color value and name as that of the

swatch you dragged from Swatch Palette window. You can edit swatch name later if

you like: double-click name of swatch in the list and type new name.

2. (Arrows number 2 on pictures below) To change color value of existing swatch in col-

ors list of document window drag color patch from Swatch Palette window list view

or swatch view area to small color patch rectangle that shows color representation of

the swatch you want to change. All objects in Excentro document that were assigned this

swatch color will have their color value updated to new one as well. If name of the

swatch was created automatically after adding this swatch from Color Mixer window it

will be changed to the name of the swatch you dragged from Swatch Palette window

(if this name will be a unique name in the colors list).
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CHAPTER 9: TOOLBAR

Toolbar is a special utility window that hosts buttons with shortcuts to most frequently

used commands of Excentro menus and selector buttons for tools to be used in preview

windows of Excentro documents. Toolbar window floats above layer of Excentro docu-

ment windows like inspectors and other utility windows do, but has additional ‘anchor-

ing’ option: it can be either ‘anchored’ — ‘glued’ to top left corner of computer screen, or

‘unanchored’ — moved to arbitrary location like other utility windows.

Buttons and controls of Toolbar are grouped into five sections based on their function-

ality: Commands, Structure, Document Zoom, Tools and Memory Status. Last sec-

tion Memory Status is visible only under Mac OS 9 operating system, because Mac OS X
system architecture does not have application memory limitations of its earlier prede-

cessors.

Toolbar submenu of Window menu allows you to configure Toolbar appearance and

visibility to your personal preferences.

To bring Toolbar window to screen, if it is hidden, you can use Show Toolbar com-

mand from the submenu. This is the only active command of Toolbar submenu when

Toolbar window is hidden.

When Toolbar window is visible Show Toolbar command title changes to Hide

Toolbar and choosing it again will hide Toolbar. You may want to hide Toolbar if you

need few additional pixels of computer screen to position document windows and do

not want Toolbar to float around like inspector windows. In this case you will have to

explicitly use menu commands instead of their toolbar buttons.
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TOOLBAR SCREEN LOCATION

While Toolbar window is anchored it is ‘glued’ to top left corner of computer screen,

just below the menu bar. You can not move it from this location or position document

and utility windows so that they overlap the area occupied by Toolbar window. This is

default option for Toolbar because it makes it more convenient to use.

When Toolbar window is unanchored it floats above document windows layer just like

inspectors and other utility windows. You can position it wherever you like on your

monitor. This way you can free few pixels in top left corner without hiding Toolbar

window from view. But it also makes it more difficult to click Toolbar buttons with

mouse pointer.

To anchor Toolbar window use Anchor Toolbar command from Toolbar submenu of

Window menu. This command title reflects state of Toolbar window and when

Toolbar is anchored its title changes to Unanchor Toolbar. Choosing this command

in this state will unanchor Toolbar window.
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TOOLBAR SECTIONS

Toolbar has five sections that group buttons and controls according to their functions.

You can use Toolbar submenu to show or hide any of these sections. When you choose

section title from the submenu, Toolbar window size changes to accommodate buttons

of this section and they become visible. If you choose this section title again, it disap-

pears and Toolbar window size shrinks back. You can also hide unwanted Toolbar sec-

tions with small ‘x’ buttons on left of the section name in Toolbar window (shown with

green circles on picture below). Check mark symbol beside section title in Toolbar sub-

menu indicates visible sections.

Rest of this chapter provides short reference of all sections of Excentro Toolbar and

their buttons. We will not give you detailed description of every button and its associated

command in Excentro menu bar, because this would make this chapter the largest one in

Excentro reference books and it will be very difficult to read. If you need more informa-

tion about these Toolbar buttons and menu commands, please, see appropriate chap-

ters of Excentro Commands Reference for usage details and illustrations.

COMMANDS SECTION

Commands is the first Toolbar section. It contains four buttons with shortcuts to most

frequently used commands of File menu. They help you to create new documents,

locate and open existing documents, save changes and export guilloche designs to

Adobe Illustrator format with single button click. Please, see Chapter 1: File Menu of

Excentro Commands Reference for details and illustrations on these commands.

■ New button. This button serves as shortcut to New… command (Cmd-N) from File

menu that creates new Excentro documents. You can click this button if you want to cre-

ate completely new guilloche design not based on any existing document or stationary

template.

■ Open button. This button serves as shortcut to Open… command (Cmd-O) from

File menu that opens files of Excentro documents earlier saved to disk or creates new

documents from stationary templates.
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■ Save button. This button serves as shortcut to Save command (Cmd-S) from File

menu that can be used to save to disk changes you made to Excentro document. If the

document was never saved before and does not have accompanying file on disk, stan-

dard Mac OS Save dialog will appear in front of you, where you can enter file name and

browse disk for appropriate place to save it to.

■ Export button. This button serves as shortcut to Export… command (Cmd-P) from

File menu that can be used at the final steps of your guilloche creation process in

Excentro to save ready designs in Adobe Illustrator file format.

STRUCTURE SECTION

Structure is the second Toolbar section. It contains shortcuts to commands of

Structure menu. With these buttons you can do all guilloche construction operations

without ever going to Structure menu. Buttons icons also give you additional visual

feedback as to what this button and its associated command action does, that helps you

to choose proper action faster. Please, see Chapter 3: Structure Menu of Excentro

Commands Reference for details and illustrations on these commands.

■ New Base button. This button serves as shortcut to New Base command (Cmd-B)

from Structure menu that creates new root ‘base' elements of guilloche structure tree.

■ New Element button. This button serves as shortcut to New Element command

(Cmd-E) from Structure menu that can be used to create all other elements of guil-

loche structure except root ‘base’ elements.

■ Duplicate button. This button serves as shortcut to Duplicate Element command

(Cmd-D) from Structure menu that allows you to create an exact copy of selected ele-

ment in structure pane of main document window.
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■ Delete button. This button serves as shortcut to Delete Element command from

Structure menu that deletes selected element in structure pane of main document win-

dow.

■ Change Base button. This button serves as shortcut to Change Base command

from Structure menu that allows you to change parent element of selected element in

structure pane of main document window.

■ Change Second Base button. This button serves as shortcut to Change Second

Base command from Structure menu that changes second parent element (or ‘second

base’) of content element.

■ Set Direction button. This button serves as shortcut to Set command of Direction

submenu in Structure menu that allows you to set another element as direction ele-

ment of selected element.

■ Restore Direction button. This button serves as shortcut to Restore command of

Direction submenu in Structure menu that restores direction element of selected ele-

ment to its parent element.

DOCUMENT ZOOM SECTION

Document Zoom section has shortcuts to zoom commands from View menu. These

commands help you to set magnification for graphics in preview document window.

Numeric magnification field also informs you about current magnification value that

preview window of selected document has. Please, see Chapter 5: View Menu of

Excentro Commands Reference for details and illustrations on these commands.
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■ Zoom Out button. This button serves as shortcut to Zoom Out command (Cmd-–)

from View menu that selects previous magnification value from predefined magnifica-

tion values list: 6.25%, 12.5%, 25%, 50%, 75%, 100%, 200%, 400%, 800%, 1600%, 3200%,

6400%.

■ Magnification field. This field shows you magnification value of current preview

document window and lets you to change this value directly by typing new value from

keyboard. Pop-up menu beside this field allows you to explicitly select magnification

value for preview document window from predefined list.

■ Zoom In button. This button serves as shortcut to Zoom In command (Cmd-=)

from View menu that selects next magnification value from predefined magnification

values list: 6.25%, 12.5%, 25%, 50%, 75%, 100%, 200%, 400%, 800%, 1600%, 3200%, 6400%.

■ Actual Size button. This button serves as shortcut to Actual Size command (Cmd-

1) from View menu that sets magnification value of current document preview window

to 100%. This allows you to see graphics at its ‘real size’, not in zoomed in or zoomed out

state. After that this button appears in selected (pressed) state, until you set other magni-

fication value.

■ Fit Page button. This button serves as shortcut to Fit Page command (Cmd-0)

from View menu that calculates and sets new magnification value so that whole page

size of the document fits into preview window. You can use this command if you want

see overview of all document graphics content quickly. After that this button appears in

selected (pressed) state, until magnification value or window size will be changed.
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■ Fit Width button. This button serves as shortcut to Fit Width command (Cmd-2)

from View menu that uses horizontal page size dimension (width of the document) to

calculate and set new magnification value. When you choose this command, document

preview will be scaled to fit width of the document into preview window. After that you

will be able to see whole document content using only vertical scroll actions. This but-

ton will appear in selected (pressed) state, until magnification value or window size will

be changed.

TOOLS SECTION

Tools section allows you to select current tool to be used on graphics in preview docu-

ment window. After new tool is selected mouse cursor in preview window changes

accordingly. Please, see Chapter 4: Document Preview Window of this reference for

more details and illustrations.

■ Selection Tool. You can use this tool to select object of Excentro document by click-

ing with mouse pointer path that belongs to this object. Cursor shape for Selection

Tool is standard ‘Arrow’ cursor. If it is not currently selected tool of Toolbar, you can

temporarily switch to Selection Tool by pressing down Command key.

■ Zoom Tool. You can use this tool to enlarge parts of document preview window.

Cursor shape for Zoom Tool is standard ‘Magnifier Lens’ cursor. Press mouse button

within document preview window and holding the button down drag mouse cursor to

select area you want to see enlarged. Release mouse button when you are ready and

magnification value of graphics preview will be changed. Pressing down Option key

you may switch between Zoom In and Zoom Out actions. If it is not currently selected

tool of Toolbar, you can temporarily switch to Zoom Tool by pressing down

Command-Space key combination.

■ Measure Tool. You can use this tool to measure distance and angle between two

points in document preview window. Cursor shape when Measure Tool is selected

changes to standard ‘Cross’ cursor. Click first point and holding down mouse button

drag cursor to second point you want to measure distance to. To lock measure directions

to 45° angles (0°, 45°, 90°, 135°, …) hold down Shift key. Measurement information is

shown in tools information area in top part of document preview window.
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■ Hand Tool. You can use this tool to scroll content of document preview window in

arbitrary direction. Cursor shape for Hand Tool is standard ‘Hand’ cursor. If Hand Tool

is not currently selected tool of Tools section you can temporarily switch to it by press-

ing and holding down Space key.

MEMORY STATUS SECTION

Memory Status is the last section of Toolbar window. It informs you about current

Excentro application memory usage, so you could avoid low memory situations before

they arise and take appropriate actions: you can close some windows or zap document

undo lists (see Zap Document Undos command description in Chapter 2: Edit

Menu of Excentro Commands Reference).

Memory Status section is not used or visible under Mac OS X operating system because

application memory handled differently under this more advanced operating system

and frequent low memory situations are unlikely to happen.
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CHAPTER 10: OTHER DIALOGS

In this chapter of Excentro Windows Reference we provide detailed descriptions of

Excentro application modal dialogs. These dialogs are brought to screen as a part of

action sequence originated by some menu command and require user attention and

input before you can proceed further. Short descriptions of these dialogs could be found

in Excentro Commands Reference book in sections that cover appropriate menu

commands. This chapter gives you more detailed reference of the dialogs in case you

have questions about purpose of their controls and buttons or wonder what different

options might be.

NEW DOCUMENT DIALOG

You will see New Document dialog after you choose New… command (Cmd-N) from

File menu to create new Excentro document or use Toolbar shortcut button to this

command.

In this dialog you can type new document name in top Name field, select appropriate

page format and page orientation in lower Document Setup section.

Document Name could be any string up to 255 characters long that will help you to

correctly identify this document later. This name will be shown in document windows

and it will appear in standard Mac OS Save dialog when you will try to save this docu-

ment to file on hard disk later. By default new document name is ‘untitled’. If there is

already exists opened Excentro document with ‘untitled’ name, numeric index will be

added to this string: ‘untitled 2’, ‘untitled 3’, etc.
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In Document Setup section you can define work area for new guilloche design.

Document page size and orientation help to visually limit work area in document pre-

view window, so sizing and positioning of objects and paths will be easier tasks to do.

Work area is shown as thin black rectangle (see picture below). You can change it later

with Document Setup command.

To set new document page size you can use one of predefined formats in Page size pop-

up menu. List of predefined formats in Page size pop-up menu can be changed in Page

Size panel of Excentro Preferences dialog. You can also select Custom format item

from the pop-up menu and type new page size using numeric Width and Height fields.

(These fields will become active after Custom format item is chosen.)

Page Orientation buttons allow you to set Portrait or Landscape orientation for

your new document. Width and Height fields will swap their values as you toggle

between orientation options.

Portrait orientation is selected. Landscape orientation is selected.

When you finished with New Document dialog click OK button and new Excentro
document will appear in front of you. To cancel new document creation click Cancel

button.

Excentro Windows Reference

Chapter 10: Other Dialogs

10-2

Work area defined by
document page size
and orientation



DOCUMENT SETUP DIALOG

Document Setup dialog appears after you choose Document Setup… command

from File menu.

This dialog helps you to change document work area originally defined with New Doc-

ument dialog (see previous section). You can do this at any convenient time if docu-

ment resizing is needed.

You can select one of predefined formats from Page size pop-up menu. List of prede-

fined formats can be edited in Page Size panel of Excentro Preferences dialog. You

can also select Custom item from pop-up menu and type new page size using numeric

Width and Height fields.

Document setup for standard A4 certificate.
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Document setup for custom page design.

You can make a choice between Portrait or Landscape orientation for your document:

Width and Height fields swap their values when you change document orientation.

When you finished with Document Setup dialog click OK button and Excentro docu-

ment will be resized to new values. You can also click Cancel button to return to previ-

ous document work area size.

ZOOM TO DIALOG

Zoom To dialog appears when you choose Other… item in Zoom submenu of View

menu.

In this dialog you can type new magnification value for preview window of current

Excentro document, instead of selecting one of predefined values with other items of

Zoom submenu or using Zoom In and Zoom Out commands.
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You can also select one of predefined values from pop-up menu beside Magnification

text field. These are the same predefined values as in Zoom submenu, so it is not

required to use Other… command and Zoom To dialog just to select one of these.

After you finished with magnification value selection in Zoom To dialog, you can click

OK button to apply new value or Cancel button to close dialog and return to previous

value.

Example of Zoom To dialog usage. Magnification value of document preview window is
changed from 100% to 300%.

Toolbar has similar magnification value field and pop-up menu with predefined values

that could be used instead of items in Zoom submenu or Zoom To dialog.
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CHAPTER 11: OTHER WINDOWS

This final chapter of Excentro Windows Reference covers two least interesting win-

dows of Excentro application: About Excentro window and Clipboard window. Every

Mac OS application have similar windows, so you, probably, will never look into this

chapter to find any new information. We provide description of these windows ‘just in

case’, to make this reference book more complete.

Both About Excentro window and Clipboard window serve informational function

without much practical use: About Excentro window shows information about your

copy of Excentro application and Clipboard window displays content of application

clipboard buffer.

ABOUT EXCENTRO WINDOW

About Excentro window could be summoned to screen with About Excentro… com-

mand. This command is located under Apple menu, if Excentro runs under Mac OS 9 or

Excentro Application menu under Mac OS X.

About Excentro window shows string with version number for your copy of Excentro
and scrolling string with copyright information and credits.

This window also shows string with internet address of Excentro page at Excourse web

site. If you click this line with mouse pointer your web browser will be opened and the

page will be loaded automatically (your Macintosh should be connected to internet to

access pages on World-Wide-Web)
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CLIPBOARD WINDOW

Clipboard window could be made visible with Show Clipboard command from Edit

menu:

■ If Clipboard window was closed or hidden before choosing Show Clipboard

command, it will appear on screen.

■ If Clipboard window was visible, but overlapped by other windows or mini-

mized, Show Clipboard command will be bring it in front of you.

Clipboard window displays Clipboard buffer content: text, graphics or Excentro object

that was cut or copied to it with Cut and Copy commands from Edit menu. You can use

this window to check if Clipboard has right object before pasting it back to document

with Paste command. You can not do anything with this window except looking at its

content and closing it afterwards.

Clipboard window with three different content types: text, graphics and Excentro object.
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